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LESSON 1 -  
CREATING TABLES  

In this lesson, you will learn how to: 

• Use the Database Wizard  

• Create a new database  

• Design tables  

• Create a table in Design view  

• Use Design view  

• Add field names  

• Assign data types  

• Add a field description  

• Set a primary key  

• Save a new table  

• Use the Table Wizard  
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USING THE DATABASE WIZARD 

 Discussion 
When you create a database in Access, you are creating a container for related tables, 
forms, queries, reports, and other database objects. You can create a new database 
manually or with the help of the Database Wizard. If you create a new database 
manually, you must then create your own tables, queries, and other objects. To save 
time, you can use the Database Wizard. 
 
Access 2002 offers several Database Wizard templates you can use to quickly create a 
database. The Database Wizard templates include preformatted database objects, such 
as tables, forms, and reports. A variety of business and personal Database Wizard 
templates are available on the Databases page in the Templates dialog box. If you use 
any Database Wizard template, Access creates not only the database, but also the 
tables, queries, and other objects in it. 
 
When you use the Database Wizard, you select the fields you want to use in the 
database tables, the desired screen style, and the desired report style. Lastly, you can 
add a database title, include a picture on reports, and choose whether to open the 
database in the Database window or start the database from its Switchboard. The first 
time you start the database, a message box prompts you to enter your name and 
address information. After you have provided this information, the Main Switchboard 
(a form containing command buttons and other objects to help you navigate and use 
the database) opens. 
 
After you have used a Database Wizard template, a link to it appears under New from 
template in the New File task pane. You can click this link to quickly create another 
database using the same template and settings. 

 
Using the Database Wizard to create a new database 
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When you create a new database, it is saved in the default file 
format for Access 2000 so that it can be opened in Access 
2000 as well as Access 2002. To create databases to be used 
strictly in Access 2002, you can change the default file format 
by selecting the Tools menu, the Options command, and the 
Advanced tab in the Options dialog box. Then, select the 
Default File Format list and Access 2002. 

  
 

 Procedures 

1. Click the New button  on the Database toolbar. 

2. Select the General Templates link under New from template in the 
New File task pane. 

3. Select the Databases tab. 

4. Select the desired Database Wizard template. 

5. Select OK. 

6. Type the desired file name. 

7. Select the Save in list. 

8. Select the drive where you want to store the file. 

9. Open the folder where you want to store the file. 

10. Select Create. 

11. Select Next >. 

12. Select the table in the Tables in the database list box for which you 
want to view the fields. 

13. Select or deselect fields in the Fields in the table list box to include 
them in or to exclude them from the database, respectively. 

14. Select Next >. 

15. Select the desired screen style. 

16. Select Next >. 

17. Select the desired report style. 

18. Select Next >. 

19. Type the desired database title. 
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20. Select Next >. 

21. Indicate whether or not you want to start the database after the 
Database Wizard has built it. 

22. Select Finish. 

23. Select OK. 

 

CREATING A NEW DATABASE 

 Discussion 
You can create a new database in Access without using the Database Wizard; 
however, you must then create the tables, queries, and other objects in the database. 
 
When you create a new database, you must specify the desired file name, as well as 
where you want to store the database file. 
 
After you have created the database, the Database window opens. Its toolbar buttons 
allow you to open objects, modify the design of existing objects, and create new 
objects. The Objects bar in the Database window allows you to access the following 
object types: Tables, Queries, Forms, Reports, Pages, Macros, and Modules. 
Created objects can belong to any of these categories. 
 

  

 
The New File task pane closes as soon as you create a new, 
blank database. 

  

 
You can also create a new, blank database by selecting the 
General Templates link on the New File task pane and the 
Blank Database icon on the General page in the Templates 
dialog box. 

  

 
To open the New File task pane, select the File menu and the 
New command. 
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 Procedures 

1. Click the New button  on the Database toolbar. 

2. Select the Blank Database link under New in the New File task 
pane. 

3. Type the desired file name. 

4. Select the Save in list. 

5. Select the drive where you want to store the file. 

6. Open the folder where you want to store the file. 

7. Select Create. 

 

DESIGNING TABLES 

 Discussion 
In Access, there are five steps to designing a table. The first step is to develop a 
thorough understanding of the system, including all the data to be entered and all the 
reports, statistics, labels, and other output you want to generate. It is helpful to gather 
all the forms you use for input and all the reports generated from the data. This 
process serves two purposes. First, these forms and reports are invaluable when you 
begin detailing exactly what information you want stored in each table. Second, once 
you have collected a set of these forms, you can make sure that every item of 
information on your reports is either included in your database or can be derived from 
data in your database. 
 
The second step is to determine how many tables you need and what information to 
store in each table. Once you have gained an overview of the system, you are ready to 
begin designing your database. The most important decision you must make before 
you begin creating tables is how many tables you want the database to include. 
 
The third step is to design the tables by selecting the fields you want to include, the 
type of data you want to store in each field, and the size of the fields. Once you have 
developed an overview of your application and a list of tables, you can make a 
preliminary list of fields, based on the categories of information that each table will 
include. You can refine the list by considering the following: if the data is to be sorted 
or selected, it should be in a separate field; if the data is to be calculated from other 
fields, you do not need to store it in its own field; and, if the table is to be linked to 
another table, both tables should contain common fields. 
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The fourth step is to create the table structures by defining the name, data type, and 
size of the fields. 
 
The fifth and final step is to enter sample data. This step is important because it helps 
you determine whether or not the table fields are the correct size and if all the 
necessary fields have been included. You can then modify the tables as necessary. 
 

CREATING A TABLE IN DESIGN VIEW 

 Discussion 
A table is the basic building block of a database. All queries, reports, and forms use 
the fields and records in the database tables as the basis for their output. You must 
create at least one table in the database before you can create any other object. 
 
When you create a new table, you can use either Datasheet or Design view, work in 
the Table Wizard, import data from another data source, or link to data in another data 
source. Usually, a table is created in Design view, which gives you the most control 
over the database design. 

 
The blank table in Design view 

 
  

 
You can also create a new table in Design view by double-
clicking the Create table in Design view object in the Tables 
object list. 

  

 
Datasheet view displays a grid of rows and columns. Field 
names are entered as column headings. 
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The Table Wizard uses a series of steps to help you create a 
table. You can select a sample table on which to base your 
table and choose field names from commonly used fields, such 
as LastName and CompanyName. 

  
 

 Procedures 

1. Display the Tables objects. 

2. Select the  New button on the Database window toolbar. 

3. Select Design View. 

4. Select OK. 

 

USING DESIGN VIEW 

 Discussion 
The Design view window is split into two panes. The upper pane displays a design 
grid. You can use the rows and columns in this design grid to enter the field names, 
data types, and field descriptions for each field in the table. The small box to the left 
of each field name is the row selector. A black triangle in the row selector indicates 
the current field. 
 
The lower pane displays the properties of the selected field. A property is a 
characteristic of a field, such as the number of characters a field can contain. Access 
automatically assigns default field properties, which you can modify as desired. 
 

  

 
Once you have entered at least one field, you can press the 
[F6] key to move between the upper and lower panes of the 
Design view window. 

  
 



Lesson 1 - Creating Tables Access 2002 - Lvl 1 

Page 8 Organizational & Staff Development, U of T
 

ADDING FIELD NAMES 

 Discussion 
Field names are entered into the Field Name column in the Design view window. 
Field names are labels that identify the data stored in a field. For example, the 
OrderNumber field will most likely contain order numbers. 
 
Field names can be up to 64 characters long and can include letters, numbers, and 
spaces. (Field names, however, cannot begin with a space.) Field names cannot 
contain a period (.), an exclamation point (!), a back quote (`), brackets ([ ]), or ASCII 
control characters. In addition, field names within a table must be unique. 
 
Making field names descriptive and meaningful can help with data entry and data 
retrieval. However, you should avoid long and complicated field names because they 
can be cumbersome to remember and difficult to reference when performing database 
functions. 
 

  

 
The order in which the field names appear in Design view 
determines the order in which the columns appear in Database 
view. 

  

 
Do not include spaces in field names if you work with other 
database formats or plan to use macros with VBA (Visual 
Basic for Applications) code. 

  
 

 Procedures 

1. Open or create a table in Design view. 

2. Type the desired field name. 

3. Press [Down]. 

 

ASSIGNING DATA TYPES 

 Discussion 
The field data type tells Access what kind of values you plan to store in a field and 
how much storage space to set aside for the field. Although you can change a data 
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type after a field contains data, doing so may erase some or all of the information in 
the field. 
 
The following table describes the available data types: 

 
Data Type Description 

Text Text is the default data type; a text field can contain 
any combination of letters, numbers, punctuation 
marks, and spaces. The default width is 50 characters 
and the maximum length is 255 characters. 

Memo A memo field is similar to a text field, except that a 
memo field can contain up to 65,535 characters. You 
can use memo fields for notes or long descriptions in a 
database. 

Number A number field can contain only numeric characters, a 
comma (used as a thousands separator), a period (used 
as a decimal point), and a hyphen (used as a negative 
number sign). You should use a number field only 
when you want to perform calculations using the field 
values. For example, even though zip codes and 
telephone numbers consist of numeric characters, you 
would not use them in calculations; therefore, they 
should be entered in text rather than number fields. 

Date/Time The Date/Time data type is used for dates and/or times. 
Access automatically validates all entries to ensure that 
they are valid dates and/or times. For example, Access 
will not allow you to enter 2/31/99 because February 
does not have 31 days. Date/Time fields are useful in 
performing calculations on dates and times. 

Currency The Currency data type is similar to the Number data 
type and can be used in calculations. However, the 
values in a currency field can have a maximum of four 
decimal places and automatically appear with dollar 
signs and thousands separators (commas). You should 
use currency fields whenever possible because they use 
fixed point calculation, which is faster than the floating 
point calculation used in number fields. 

AutoNumber The AutoNumber data type allows Access to 
automatically assign a unique number (consecutively 
from 1) to each record in the database. You cannot 
manually enter a value into an AutoNumbered field or 
change a number Access has assigned to a record. You 
use this data type when you want a unique 
identification number for each record. 
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Data Type Description 

Yes/No A Yes/No data type is used to signify one of two 
conditions, Yes or No. You use a yes/no field when 
only two possibilities (i.e., True or False) exist for a 
field value. 

OLE object The OLE object data type allows you to either embed 
an object created in another Windows application or 
create a link to such an object. You use an OLE object 
data type for graphics, spreadsheets, or sound files. 

Hyperlink A Hyperlink data type is used to store a link to 
anywhere you choose. The link could go to an Internet 
page, a Word document on an intranet, or even a form 
in the current database. A hyperlink field can contain a 
description, an address, and a sub-address [separated by 
number signs (#)], as well as up to 2,048 characters; 
only the address, however, is mandatory. 

Lookup 
Wizard 

The Lookup Wizard data type allows you to create a 
lookup field. A lookup field displays a list of values 
that are either stored in another table or created by you. 
A lookup field allows you to choose values from a list 
during data entry, thereby reducing repetitive typing 
and eliminating typing errors. 

 

 
Assigning a data type 
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 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the Data Type column in the field for which you want to 
change the data type. 

4. Select the Data Type list. 

5. Select the desired data type. 

 

ADDING A FIELD DESCRIPTION 

 Discussion 
You can use the Description column in the design grid to enter a description for each 
field. The description appears on the status bar when the field is accessed on a form. 
You can enter brief comments as to the purpose of the field or the data that should be 
stored in it. 
 

 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the Description column in the field to which you want to add 
a description. 

4. Type the desired description. 

 

SETTING A PRIMARY KEY 

 Discussion 
Access works most efficiently if you specify a primary key for each table. The 
primary key is a field or group of fields that uniquely identifies each record in the 
table. Therefore, the value of the key field, or the combined values of a group of key 
fields, must not be found in more than one record. Consequently, a LastName field 
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would be a poor primary field, because several records may have the same last name; 
it would not, therefore, be unique. 
 
There are several advantages to setting a primary key. First, the primary key is 
automatically indexed, which makes information retrieval faster. Second, when you 
open a table, the records are automatically sorted in order by the primary key. Finally, 
a primary key prevents the entry of duplicate data because Access does not allow 
duplicates in the primary key field. 
 

  

 
If you have trouble identifying the primary key field, you can 
create an AutoNumber field and designate it as the primary 
key. 

  

 
You cannot choose a memo, OLE, or hyperlink field as the 
primary key. 

  

 
To create a multi-field primary key, hold the [Ctrl] key, click 
the desired fields, and then click the Primary Key button on 
the Table Design toolbar. 

  
 

 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the field you want to designate as the primary key. 

4. Click the Primary Key button  on the Table Design toolbar. 

 

SAVING A NEW TABLE 

 Discussion 
After you have designed the fields for a table, you must save the table before you can 
add any data. When you save a new table, you should give it a name that describes the 
records it stores. You can use up to 64 characters, including spaces. These characters 
can include letters, numbers, and spaces. They cannot contain a period (.), an 
exclamation point (!), a back quote (`), brackets ([]), or ASCII control characters. 
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After you have saved a table, an icon for it appears in the Tables object list in the 
Database window. 
 

  

 
When you save a table for the first time, Access opens the 
Save As dialog box, in which you enter the desired table 
name. 

  

 
When you save a table, you are not creating a file. You are 
adding an object to the existing database. 

  
 

 Procedures 

1. Create a table in Design view. 

2. Enter the desired table data. 

3. Click the Save button  on the Table Design toolbar. 

4. Type the desired table name. 

5. Select OK. 

 

USING THE TABLE WIZARD 

 Discussion 
The Table Wizard leads you through the steps needed to create a new table. The Table 
Wizard provides many table templates for typical business and personal use. You 
select the type of table you want to create, and then the fields you want to add to the 
table. 
 
The Table Wizard allows you to relate your new table to an existing table in your 
database. However, if your database does not contain any tables when you begin the 
Table Wizard, you will not be prompted to relate tables. 
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The Table Wizard 

 
  

 
You can use the right-pointing, double arrow button on the 
first page of the Table Wizard to add all the fields in the 
Sample Fields list to your new table. The left-pointing arrow 
buttons allow you to remove either the selected field or all 
fields from the Fields in my new table list box. 

  

 
You can rename any field in the Fields in my new table list 
box by selecting it and then selecting the Rename Field 
button. 

  

 
You can also activate the Table Wizard by double-clicking the 
Create table by using wizard object in the Tables object list. 

  
 

 Procedures 

1. Display the Tables object list. 

2. Select the  New button  on the Database window toolbar. 

3. Select Table Wizard. 

4. Select OK. 

5. Select the Business or Personal option, as desired. 

6. Select the desired table from the Sample Tables list box. 
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7. Select a field you want to add to your table from the Sample Fields 
list box. 

8. Select  to the right of the Sample Fields list box. 

9. Add other fields as desired. 

10. Select Next >. 

11. Type the desired table name in the What do you want to name your 
table? box. 

12. Select the desired primary key option. 

13. Select Next >. 

14. If you chose to set your own primary key, select the What field will 
hold data that is unique for each record? list. 

15. Select the desired field. 

16. Select the desired data option for the primary key field.  

17. Select Next >. 

18. Review or create table relationships, as desired. 

19. Select Next >. 

20. Select the desired view option. 

21. Select Finish. 

 



 

 

LESSON 2 -  
SETTING FIELD PROPERTIES  

In this lesson, you will learn how to: 

• Use field properties  

• Limit field size  

• Set number formats  

• Set date/time formats  

• Set yes/no formats  

• Set default values  

• Set validation rules  

• Create an input mask - wizard  

• Create an input mask manually  

• Create a custom input mask  

• Type a lookup list  

• Modify Lookup properties  
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USING FIELD PROPERTIES 

 Discussion 
Each field has a set of properties that control the way it stores, handles, and displays 
data. Since forms and reports you create use the fields in your tables, setting field 
properties in the early stages of building a database can save you time later on; you 
will have less design work to do in later stages if you set the desired field properties 
before you create any forms and reports. 
 
You normally set field properties when you create a table in Design view. If you have 
created and saved a table using default field properties, you can open the table in 
Design view to change its property settings. 
 
The properties available in the Field Properties pane depend on the data type 
assigned to the selected field. Some of the property types you can set are listed in the 
following table: 

 
Property type Description 

Field Size Limits a Text field to a specific number of 
characters; limits a Number field to a specific 
type of number 

Format Controls the way values appear in Datasheet 
view 

Decimal places Available for Number and Currency fields only, 
determines how many decimal places will appear 
in the field; this property type has no effect on 
Number fields using the General format 

Input Mask Creates a pattern for data entered into the field 
(such as adding hyphens within a telephone 
number) 

Caption Creates a label other than the field name; the 
caption will appear in the table and on forms and 
reports 

Default Value Specifies the value you want to appear in the 
selected field in all new records 

Validation Rule Forces data entered into the selected field to meet 
a specified requirement; for example, you can 
specify that the Credit Limit field not be over 
$10,000 
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Property type Description 

Validation Text Creates an error message to appear when the data 
entered violates a validation rule 

Required Specifies that the field cannot be left empty 

Allow Zero Length Determines whether or not you can enter 
quotation marks (“ ”) in a Text, Memo or 
Hyperlink field to indicate that there is no data 
for that field 

Indexed Speeds up retrieval of data in a field; all primary 
key fields are automatically indexed 

 
 

  

 
A brief description of the selected property appears in the 
Field Properties pane. 

  

 
You can press the [F1] key for help with the selected property. 

  
 

LIMITING FIELD SIZE 

 Discussion 
Setting a field size limits the number of characters or the type of characters you can 
enter into a field. After typing the maximum number of characters allowed, further 
keystrokes are not permitted. The Field Size property is available only for Text, 
Number, and AutoNumber data types; all other data types have default sizes that are 
set automatically. 
 
For a Text field, the field size is the maximum number of characters you want to 
allow in the field, up to the maximum of 255 characters allowed by Access. For a 
Number field, you can select one of the following Field Size options: 

 
Field Size Size Range Decimal Places 
Byte 0 to 255 (no fractions) None; data is 

rounded 
Integer -32768 to 32767 (no fractions) None; data is 

rounded 
Long Integer -2,147,483,648 to 

2,147,483,647 (no fractions) 
None; data is 
rounded 

Single -3.4x1038 to 3.4x1038 Up to 7 
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Field Size Size Range Decimal Places 
Double -1.797x10308 to 1.797x10308 Up to 15 
Replication ID Globally unique identifier. Not available 
Decimal -1038 to 1038  Up to 28 

 
For an AutoNumber field, only the Long Integer and Replication ID options are 
available. 
 

  

 
The default field size for Number fields is Long Integer, 
which is also the largest field size. You should use the 
smallest possible field size whenever possible, however, so 
that the database uses less storage space and can be processed 
more quickly. 

  
 

  

 
You may lose existing data if you decrease the size of a field. 
In addition, you cannot undo design changes after you have 
saved the table. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set the field size property. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Field Size property. 

5. Select the Field Size list, or type the desired value. 

6. Select the desired option, if applicable. 

 

SETTING NUMBER FORMATS 

 Discussion 
The Format property affects how data appears in Datasheet view, not how it is stored 
in the table nor how it is used in calculations. If a Number data type field is formatted 
with 0 decimal places, for example, a value of 1.5 would appear as 2 in the datasheet; 
if the value is multiplied by 2 in a calculation, however, the answer would be 3, not 4. 
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The available formats for fields with Number data types are listed in the following 
table: 

 
Format Description 

General Number Displays a number exactly as it is entered; this is 
the default format 

Currency Displays a dollar sign, a thousands separator, and 
two decimal places; the defaults for this format are 
determined by the system settings 

Euro Displays a euro sign, a thousands separator, and 
two decimal places; the defaults for this format are 
determined by the system settings 

Fixed Displays at least one digit and is rounded to the 
default number of decimal places; the defaults for 
this format are determined by the system settings 

Standard Displays a thousands separator and is rounded to 
the default number of decimal places; the defaults 
for this format are determined by the system 
settings 

Percent Multiplies the number by 100, displays a percent 
sign (%), and is rounded to the default number of 
decimal places; the defaults for this format are 
determined by the system settings 

Scientific Expresses numbers in standard scientific notation 
(as multiples of exponents of 10) 

 

 
Selecting a number format 



Access 2002 - Lvl 2 Lesson 2 - Setting Field Properties 

Organizational & Staff Development, U of T Page 21
 

 
  

 
You can change number defaults on your system by opening 
the Control Panel and selecting the Regional Options icon. 

  

 
The Format property list displays how a number will be 
formatted for format types other than Text and Memo. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set a number format. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Format property. 

5. Select the Format list. 

6. Select the desired format. 

 

SETTING DATE/TIME FORMATS 

 Discussion 
You can also change the format of a Date/Time field to change the way the date or 
time appears in the table. The available formats for Date/Time fields are listed in the 
following table: 

 
Format Description 

General Date The default format; if the value is only a date, no time 
appears; if the value is only a time, no date appears 

Long Date The day and month names are spelled out (e.g., 
Tuesday, July 4, 1995) 

Medium Date The month name is abbreviated, and the name of the 
day is omitted (e.g., 04-Jul-95) 

Short Date The date appears as numbers separated by slashes 
(e.g., 7/4/95) 
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Format Description 

Long Time The time is displayed as hours, minutes, and seconds, 
separated by colons, and followed by an AM or PM 
indicator (e.g., 6:30:15 PM) 

Medium Time The time is displayed the same as in the Long Time 
format, except that no seconds appear (e.g., 06:15 
PM) 

Short Time The time is displayed as hours and minutes, separated 
by a colon, in 24-hour clock format (e.g., 18:30) 

 
 

  

 
You can change the date and time defaults for your system by 
selecting the Regional Options icon from the Control Panel. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set a date/time format. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Format property. 

5. Select the Format list. 

6. Select the desired format. 

 

SETTING YES/NO FORMATS 

 Discussion 
A Yes/No field is limited to either a positive or a negative response and can be 
displayed as a text box, a check box, or a combo box. You select the display of the 
field on the Lookup page in the Field Properties pane. 
 
If the Yes/No field displays its values in a text box, you can select one of three 
Yes/No data type formats; True/False, Yes/No, and On/Off. Regardless of the format 
selected, the positive responses of True, Yes, and On are equivalent, just as the 
negative responses of False, No and Off are equivalent. Consequently, if the Yes/No 
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field is set to the True/False format and a user enters Yes, Access automatically 
converts it to True. 
 
When a Yes/No field displays a check box, a selected check box indicates a positive 
response and a deselected check box indicates a negative response. The check box is 
the default setting for a Yes/No field. 

 
Selecting a Display Control property 

 
  

 
If no format is set, an entry of Yes, True or On displays a 
field value of -1, and an entry of No, False, or Off displays a 
field value of 0. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set a yes/no format. 

3. Select the General page in the Field Properties pane, if necessary.  

4. Select the Format property.  

5. Select the Format list. 

6. Select the desired yes/no format. 

7. Select the Lookup tab. 

8. Select the Display Control list. 

9. Select the desired yes/no control. 

 



Lesson 2 - Setting Field Properties Access 2002 - Lvl 2 

Page 24 Organizational & Staff Development, U of T
 

SETTING DEFAULT VALUES 

 Discussion 
When you set a default value for a field, that value automatically appears in the field 
for all new records. You can, however, modify the default field value as needed when 
entering a new record.  
 
A default value can save you time when entering data. For example, if a table stores 
the names and addresses of clients and most of the clients have addresses in New 
York, you can set the default value of the State field to NY. If you then enter a new 
record for a client in Connecticut, or if a client moves out of New York, you can 
change the value in the State field just for that individual record. Setting a default 
value for an established table, however, does not modify existing records. 
 
You can set a default value by entering the desired value or expression in the Default 
Value box. An expression consists of operators (i.e. =, +, -, *, /) and/or values. 
 
If you create a default value for a Text field, the default text must be enclosed in 
quotation marks (" "); for example, "Net 30". Values for Date fields must be 
enclosed in number signs (#); for example, #1/15/95#. If you do not enter the number 
signs, however, Access will automatically enter them. 
 

  

 
You cannot set a default value for fields with AutoNumber or 
OLE object data types. 

  

 
You can also use the Expression Builder to create a default 
value. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set a default value. 

3. Select the General page in the Field Properties pane. 

4. Select the Default Value box. 

5. Create the desired default value. 

6. Press [Enter]. 
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SETTING VALIDATION RULES 

 Discussion 
Databases can contain incorrect information due to data entry errors. One method of 
controlling the accuracy of data is to impose restrictions on the values entered into a 
field. 
 
You can impose restrictions on data entered into your table by creating validation 
rules in the Validation Rule box of one or more fields. When you enter data into a 
new record or modify data in an existing record, Access checks each field for existing 
validation rules. If an entry does not meet the conditions of the corresponding 
validation rule, a warning box notifies you of the error. When you set a validation 
rule, you use the Validation Text box to specify the text you want to appear in the 
warning box. 
 
Setting a validation rule is different from setting the data type or field size properties. 
Access uses data type and field size properties to determine that the correct type of 
data is being entered. Validation rules are more specific in their restrictions. For 
example, you can create a validation rule to ensure that numbers entered in a 
particular field are between 500 and 1000. 

 
Creating a validation rule with validation text 

 
  

 
You can also use the Expression Builder to set a validation 
rule. 
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 Procedures 

1. Open the desired table in Design view. 

2. Select the field for which you want to set a validation rule. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Validation Rule box. 

5. Enter the desired validation rule. 

6. Select the Validation Text box. 

7. Enter the desired validation text. 

 

CREATING AN INPUT MASK - WIZARD 

 Discussion 
Input masks control how data is entered into a table, as well as the format in which it 
is stored. You can use an input mask to control how many characters are entered into a 
field; define each individual character as numeric, text, or either; and specify each 
individual character as mandatory or optional, as well as add literal characters to 
format the entry. Since the input mask controls the values users can enter into a field, 
it often makes data entry easier. 
 
You can create an input mask by entering the criteria directly into the Input Mask 
box. However, it is often easier to use the Input Mask Wizard to set the property for 
you. The Input Mask Wizard offers several predefined input masks for items such as 
dates and times, ZIP codes, telephone numbers, etc. In addition, you can modify any 
predefined input mask to meet your needs. 



Access 2002 - Lvl 2 Lesson 2 - Setting Field Properties 

Organizational & Staff Development, U of T Page 27
 

 
The Input Mask Wizard 

 
  

 
You can get help on creating or modifying input masks by 
selecting the Input Mask box and pressing the [F1] key. 

  

 
An input mask only affects new entries; data that has already 
been entered into a field is not affected if an input mask is 
later. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field to which you want to apply an input mask. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Input Mask property. 

5. Click the Build button. 

6. Select the desired option from the Input Mask list. 

7. Select Next. 

8. Select the Placeholder Character list. 

9. Select the desired placeholder. 

10. Select Next.  
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11. Select the desired option for storing the data. 

12. Select Next. 

13. Select Finish. 

 

CREATING AN INPUT MASK MANUALLY 

 Discussion 
An input mask controls what values you can enter in a field, as well as how the data 
will appear. Although it is usually easier to use the Input Mask Wizard, you may need 
to create an input mask that is not included in the list of predefined masks in the Input 
Mask Wizard. Access allows you to create an input mask by entering criteria directly 
into the Input Mask box. 
 
When you create an input mask manually, you use special characters to define it. 
These special characters act as placeholders, controlling the type of character that can 
be entered into each position, as well as which characters are required. For example, 
the (999) 000-0000 input mask allows you to enter only digits, and the area code is not 
required; consequently, both ( ) 555-6545 and (804) 555-6545 are valid entries for this 
input mask. 
 
The following table defines some of the special characters that can be used in an input 
mask. To define a literal character, enter any character other than one of those shown 
in the table. If you want to define a character listed in the table as a literal character, 
you must precede that character with a backslash (\). 

 
Character Description 

0 A required numeric entry (0-9); plus and minus signs are 
not allowed 

9  An optional numeric entry (0-9) or space; plus and minus 
signs not allowed 

# An optional numeric entry (0-9) or space; plus and minus 
signs allowed 

L A required alphabetic entry (A-Z) 

? An optional alphabetic entry (A-Z) 

A  A required alphabetic (A-Z) or numeric (0-9) entry 

a An optional alphabetic (A-Z) or numeric (0-9) entry 

& Any character or space; entry required 
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Character Description 

C Any character or space; entry optional 

< Causes all characters that follow to be converted to 
lowercase 

> Causes all characters that follow to be converted to 
uppercase 

! Enters the input mask from right to left, instead of from 
left to right 

\ Causes the character that follows to be displayed as a 
literal character 

 
 

  

 
The Input Mask property can be set in Design view of any 
table, query, or form. Most of the time, you will want to apply 
an input mask to a field in table Design view, because it will 
then be automatically applied to the field in queries, forms, 
and reports. 

  

 
The Input Mask Wizard can only be used for Text and 
Date/Time fields. You must manually enter an input mask for 
Number and Currency fields. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field to which you want to apply an input mask. 

3. Select the General page in the Field Properties pane, if necessary. 

4. Select the Input Mask box. 

5. Type the desired input mask. 
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CREATING A CUSTOM INPUT MASK 

 Discussion 
The Input Mask Wizard provides a list of predefined input masks. If you frequently 
use an input mask that is not included with the predefined masks in the Input Mask 
Wizard, however, you may want to create a custom input mask. You may want to use 
an input mask, for example, to ensure that product numbers are always correctly 
entered. 
 
You can create and save a custom input mask in the Input Mask Wizard, where it is 
available to tables and forms at any time. In this way, you will only need to create a 
custom input mask once. 

 
Creating a custom input mask 

 
  

 
Input masks are saved to your user profile on your system, not 
to the individual database file. If you create a new mask, or 
modify a default one using the Customize Input Mask Wizard 
dialog box, the changes are permanently saved to your system 
settings. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the field to which you want to apply a custom input mask. 

3. Select the General page in the Field Properties pane. 

4. Select the Input Mask box. 
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5. Click the Build button . 

6. Select Edit List. 

7. Select the New button . 

8. Type the desired description for the custom input mask. 

9. Select the Input Mask box.  

10. Type the custom input mask. 

11. Select the Placeholder box. 

12. Type the desired placeholder. 

13. Select the Sample Data box. 

14. Type some sample data. 

15. Select Close. 

16. Select the custom input mask from the Input Mask list 

17. Select Finish. 

 

TYPING A LOOKUP LIST 

 Discussion 
You can increase data accuracy by adding a lookup field to a table. The user can then 
select the desired value from the lookup list, rather than having to type it. The values 
in a lookup list are usually stored in a field in a different table. If you want the initials 
of the sales rep to appear in the Sales Rep field of the Customer table, for example, 
you can create a lookup to the Initials field in the Reps table. If the desired data is not 
stored elsewhere, you can type the lookup list values. 
 
The Lookup Wizard creates a combo box field for the lookup list; a combo box field 
displays a drop-down list that displays all of the available data values. By default, a 
lookup field does not limit input to values on the lookup list; the user can type an 
entry not on the list if desired. However, you can limit a field to only those values on 
the lookup list. 
 
A lookup list can contain multiple columns. If you are typing a new list of values, you 
can designate the number of columns desired and then type the desired values into 
each column. In addition, you can add a second field to a lookup list. For example, if 
you are creating a lookup list in the Customer table, you can add both the Initials and 
the Last Name fields from the Reps table to the lookup list. 
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Typing a lookup list 

 
  

 
If you are creating a lookup list for a field that is the related 
field in a join, you must delete the join before using the 
Lookup Wizard. 

  
 

 Procedures 

1. Open the desired table in Design view. 

2. Click in the Data Type column of the field for which you want to 
create a lookup list. 

3. Select the Data Type arrow. 

4. Select Lookup Wizard.... 

5. Select the desired lookup source. 

6. Select Next. 

7. Enter the desired number of lookup columns. 

8. Select the box below the Col1 heading. 

9. Type the first desired lookup value. 

10. Enter additional lookup values as desired. 

11. Select Next. 

12. Select the column that contains the values you want to store or use. 
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13. Select Finish. 

 

MODIFYING LOOKUP PROPERTIES 

 Discussion 
You can use the Lookup page in the Field Properties pane to modify the properties of 
a lookup list. 
 
If the lookup list was manually typed, you can use the Row Source property to edit it 
or add to it. Column values are separated by semi-colons (;) and text entries are 
enclosed in quotation marks ("). 
 
The Bound Column property indicates which lookup column is used to store field 
values. For instance, if the lookup list consists of two columns, and column 1 is the 
bound column, the data in column 1 will be stored in the lookup field. 
 
Although you may want the values in the bound column to be stored in the field, they 
may be confusing and uninformative to the user; the descriptive text in an unbound 
field may have more meaning. You can suppress the display of the bound column and 
display only the descriptive text in the unbound column of a lookup list by changing 
the width of the bound column to zero (0”) in the Column Width box. 
 
By default, a lookup field allows the user to add data values to the lookup list simply 
by typing them into the field. You can limit data entry to just those values on the 
lookup list by selecting Yes in the Limit to List box; the default value of No allows 
free entry. 
 

 Procedures 

1. Open the desired table in Design view. 

2. Select the lookup field you want to modify. 

3. Select the Lookup tab in the Field Properties pane. 

4. Select the property you want to modify. 

5. Modify the property as desired 

 



 

 

LESSON 3 -  
MODIFYING TABLES  

In this lesson, you will learn how to: 

• Insert a column into a table  

• Change a column name  

• Delete a column  

• Insert a lookup column  

• Insert a hyperlink column  

• Create a many-to-many relationship  
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INSERTING A COLUMN INTO A TABLE 

 Discussion 
You may find it necessary to add fields to a table. One way of doing this is to insert 
one or more columns into the table. Inserting a column automatically adds a new field 
to the table. 
 
Columns are inserted to the left of the currently selected column; consequently, you 
can position a new field in the desired location. Although Access sets a default field 
width, provides a default field name, and assigns a default data type (Text), you can 
change any of these default settings as desired. 
 

  

 
You can also insert a column by right-clicking any column 
heading and selecting the Insert Column command. 

  

 
After adding a column, you should change the default field 
name to one that clearly identifies its contents. 

  
 

 Procedures 

1. Open the desired table in Datasheet view. 

2. Click in the column to the left of which the new column is to be 
inserted. 

3. Select the Insert menu. 

4. Select the Column command. 

 

CHANGING A COLUMN NAME 

 Discussion 
A column name should clearly indicate the information contained in the column, in 
order to make working with data easier. When you rename a column, you are also 
changing the corresponding field name; keep in mind that you cannot create duplicate 
field names. 
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Column names can be up to 64 characters long, but shorter names are recommended. 

 
Renaming a column 

 
  

 
You can also rename a column by right-clicking its heading 
and selecting the Rename Column command. 

  

 
Column names can contain spaces, numbers, and many special 
characters; a column name, however, cannot include a period 
(.), an exclamation point (!), or square brackets ([ ]). 

  

 
The column heading is also called the field selector. 

  
 

 Procedures 

1. Open the desired table in Datasheet view. 

2. Double-click the heading of the column you want to rename. 

3. Type the desired column name. 

4. Press [Enter]. 
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DELETING A COLUMN 

 Discussion 
You can delete a column from a table. When a column is deleted, the columns to the 
right of it automatically adjust. 
 
In addition, if other database objects (such as lookup tables) contain references to a 
deleted field, the appropriate error messages will be generated. 

 
Deleting a column 

 
  

 
You can also delete a column by right-clicking its heading and 
selecting the Delete Column command. 

  

 
You cannot delete a field that has a relationship to another 
table unless you first delete the relationship. 

  
 

  

 
All data contained in a deleted column is permanently deleted 
as well, and you cannot undo the deletion. 
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 Procedures 

1. Open the desired table in Datasheet view. 

2. Click in the column you want to delete. 

3.  Select the Edit menu. 

4. Select the Delete Column command. 

5. Select Yes to confirm the deletion. 

 

INSERTING A LOOKUP COLUMN 

 Discussion 
A lookup column looks up data stored in another data source, thereby eliminating the 
need to search for information when you add a record. In addition, a lookup column 
saves time because it reduces the amount of information you must type and increases 
accuracy because a list of available data values is provided. 
 
The Lookup Wizard can assist you in creating a lookup column. The values in a 
lookup column can come from another table or a query, or you can create your own 
list. For example, you may have a list of customers in one table and a list of customer 
types and information related to each customer type in another; you can use a lookup 
column in the customer table to look up customer type data in the customer type table; 
choosing the customer type from a list helps ensure the accuracy of the data. 
 
During data entry, a lookup column displays a drop-down arrow. You can use the 
arrow to access the available list of values, or you can type the desired value into the 
column. 
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Using the Lookup Wizard 

 
  

 
You can also insert a lookup column by right-clicking the 
column heading to the left of which you want to insert the 
lookup column and then selecting the Lookup Column 
command. 

  

 
You can click at the right side of a lookup column to 
automatically display the lookup list. 

  

 
You can also use the Lookup Wizard in Design view to create 
a lookup for an existing field by selecting Lookup Wizard... 
from the Data Type drop-down list to the right of the field in 
which you want to create the lookup. If the field happens to be 
a join field, you may have to delete the join before creating the 
lookup. 

  
 

 Procedures 

1. Open the desired table in Datasheet view. 

2. Click anywhere in the column to the left of which you want to insert 
the lookup column. 

3. Select the Insert menu. 

4. Select the Lookup Column command. 

5. Select the option that specifies how you want the lookup column to 
get its values. 
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6. Select Next. 

7. Select the table or query that will provide the values for the lookup 
column. 

8. Select Next. 

9. Double-click the field containing the values you want to look up to 
move it from the Available Fields list to the Selected Fields list. 

10. Select Next. 

11. Double-click the separator line to the right of any column header to 
automatically adjust the corresponding column width. 

12. Select Next. 

13. Type a label for the lookup column. 

14. Select Finish. 

 

INSERTING A HYPERLINK COLUMN 

 Discussion 
You can insert a hyperlink column into a table; a hyperlink field contains a path to 
another location, such as a network server or a page on the Internet. When you insert a 
hyperlink column, its name defaults to Field1; you can rename the hyperlink column 
as desired. 
 
After inserting a hyperlink column, you can type the hyperlink text for each record 
directly into the column, and each record can contain a different hyperlink address. 
Hyperlinks are underlined and appear in a different color. 
 

  

 
After inserting a hyperlink column, you should change the 
default field name to one that clearly identifies its contents.  

  
 

 Procedures 

1. Open the desired table in Datasheet view. 

2. Click in the column to the left of which the hyperlink column is to be 
inserted. 

3. Select the Insert menu. 
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4. Select the Hyperlink Column command. 

 

CREATING A MANY-TO-MANY RELATIONSHIP 

 Discussion 
Although one-to-many relationships are more common by far, there are times when 
you may need to create a many-to-many relationship. In a many-to-many relationship, 
a record in one table can have many matching records in another table and vice versa. 
Many-to-many relationships often apply to order and product relationships, in which 
an order can include many products and a product can appear in many orders. 
 
This type of relationship is made possible through the use of a third table, called a 
junction table, that includes its own primary key field and two foreign key fields, one 
from each of the two tables being related. A many-to-many relationship is really two 
one-to-many relationships, linked by the junction table. 
 

  

 
The Show Table dialog box opens automatically if no tables 
have been added to the Relationships window. 

  

 
You can also create relationships in the Show Table dialog 
box by selecting the tables you want to relate and pressing the 
[Enter] key. 

  
 

 Procedures 

1. Display the Database window, if necessary. 

2. Click the Relationships button  on the Database toolbar. 

3. Click the Show Table button  on the Relationships toolbar, if 
necessary. 

4. Select the tables you want to join. 

5. Select Add. 

6. Select Close in the Show Table dialog box. 

7. Drag the desired field for the first join from the junction table field 
list to the corresponding field in the related table field list. 
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8. Select the Enforce Referential Integrity option.  

9. Select Create. 

10. Drag the desired field for the second join from the junction table 
field list to the corresponding field in the second related field list. 

11. Select the Enforce Referential Integrity option.  

12. Select Create. 

13. Close the Relationships window. 

14. Select Yes to save the changes. 

 



 

 

LESSON 4 -  
CREATING RELATIONSHIPS  

In this lesson, you will learn how to: 

• Use related tables  

• Create a relationship between tables  

• Set referential integrity  

• View subdatasheets  

• Delete a join line  
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USING RELATED TABLES 

 Discussion 
Tables can be joined, or related, in order to access and coordinate information in all 
the fields of the related tables. Joining tables is a useful way to avoid entering 
duplicate information in various, related tables. In addition, it allows you to create 
reports, forms, and queries from the related data tables and save them in the database 
file. Relating tables allows you to create smaller, more efficient tables that can be 
referenced when you need access to the data. 
 
When you relate tables, the table from which you select a field to join is the primary 
table, and the second table containing the field you want to associate is the related 
table. The tables must have at least one common field that contains the same type of 
data. This common field is called the join field. The join fields in both tables must 
have the same or equivalent data types and, if they are Number fields, they must have 
the same field size. In addition, the join field in the primary table must be the primary 
key in order to avoid duplicate entries. 
 
For example, the following table consists of customer names and address fields, along 
with a unique identification number for each customer, which serves as the primary 
key in the table. You can create this number or allow Access to create it for you. 

 
ID # Names Address City State Zip 

1 Smith 11692 J St. NW Washington DC 20013 

2 Conrad 16 Allegheny Center Pittsburgh PA 16489 

3 Kane 1012 Broadway Lexington KY 40567 

4 Apple 516 Beacon Ave. Seattle WA 98051 

5 Billow 9249 Cavalcade St. Houston TX 77002 

 
You could then create a separate table consisting only of orders placed by customers. 
This table would also contain the field for the unique customer identification number, 
but not the customers’ names and addresses. 
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ID # Order 

1 Office Work Center 

2 All-In-One Corner Desk and Hutch 

3 Open-Front Steel Bookcase 

4 2-Drawer Letter File 

5 Executive Leather Chair, Black 

 
By relating the two tables through the common customer identification number field, 
the customers’ name and address does not have to be entered for every order. All that 
has to be entered is the customer identification number, along with the orders. 
 
Access includes two basic types of relationships: one-to-many and one-to-one. A one-
to-many relationship occurs when one record from the primary table matches many 
records from the related table (e.g., one customer record matches many order records). 
A one-to-one relationship occurs when one record from the primary table matches one 
record from the related table. Access determines the relationship type automatically 
when you create the relationship. 
 

CREATING A RELATIONSHIP BETWEEN TABLES 

 Discussion 
The Relationships window displays a graphic representation of database relationships 
and allows you to create relationships between tables. You drag field lists in the 
Relationships window to reposition them as needed. In addition, any field name that 
represents a primary key is bolded in the corresponding field list. 
 
You can add tables to the Relationships window for additional joins. For example, if 
the Relationships window displays only two related tables and you need to access 
information from a third table, you can easily add the required table to the 
Relationships window and then create the join. 



Lesson 4 - Creating Relationships Access 2002 - Lvl 1 

Page 46 Organizational & Staff Development, U of T
 

 
Adding a field list to the Relationships window 

 

 
The Show Table dialog box opens automatically if no tables 
have been added to the Relationships window. 

 
You can also open the Relationships window by selecting the 
Tools menu and the Relationships command or by right-
clicking in the Database window and selecting the 
Relationships command. 

 
You can select multiple tables in the Show Table dialog box 
by holding the [Ctrl] key as you click each table. Selecting 
Add adds all the selected tables to the Relationships window. 

 

 Procedures 

1. Click the Relationships button  on the Database toolbar. 

2. Click the Show Table button  on the Relationship toolbar, if 
necessary. 

3. Select the first table you want to relate. 

4. Select Add. 

5. Select the second table you want to relate. 



Access 2002 - Lvl 1 Lesson 4 - Creating Relationships 

Organizational & Staff Development, U of T Page 47
 

6. Select Add. 

7. Select Close. 

8. Drag the desired field from the first field list to the matching field in 
the second field list. 

9. Select Create. 

10. Close the Relationships window. 

11. Select Yes. 

 

SETTING REFERENTIAL INTEGRITY 

 Discussion 
When you create a relationship between two tables, you can set referential integrity. 
Referential integrity is a built-in set of rules Access uses to make sure that the 
relationship is valid. Referential integrity can also prevent accidental deletion or 
editing of data. In order to use referential integrity, the following conditions must be 
true: the related field in one table must be its primary key, the related fields in both 
tables must have the same data type, and both tables must belong to the same 
database. 
 
When you set referential integrity, you must observe the following three rules; First, 
you cannot enter data in the join field in the "many" table that does not have a match 
in the join field in the "one" table. Second, you cannot delete records from the "one" 
table if there are matching records in the "many" table. Third, you cannot edit primary 
key values if related records exist. 
 
If you want to perform any of the changes listed above, however, and still maintain 
referential integrity, you can select the Cascade Update Related Fields and Cascade 
Delete Related Records options in the Edit Relationships dialog box. If either or both 
of these options are selected, Access automatically makes the necessary changes to 
related tables to maintain referential integrity. It is recommended that these two 
options be selected only after careful consideration, since the changes cannot be 
undone. 
 
When referential integrity is enforced, Access displays symbols above the join line to 
indicate the type of relationship, one-to-one or one-to-many. The number 1 above a 
join line indicates “one”, and the mathematical symbol for infinity (which resembles a 
horizontal 8) indicates “many”. 
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Setting referential integrity 

 
  

 
Double-clicking the middle segment of any join line opens the 
Edit Relationships window with the selected join displayed. 
Double-clicking the beginning or ending segment of any join 
line opens the Edit Relationships window, but with no join 
selected. You can then use the Table/Query list to select the 
desired join. 

  

 
You can also open the Edit Relationships dialog box by 
selecting the Relationships menu and the Edit Relationship 
command or by right-clicking the join line and then selecting 
the Edit Relationship command. 

  
 

 Procedures 

1. Open the Relationships window. 

2. Double-click the middle segment of the desired join line. 

3. Select the Enforce Referential Integrity option. 

4. Select the Cascade Update Related Fields option, if desired. 

5. Select the Cascade Delete Related Records option, if desired. 

6. Select OK. 
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VIEWING SUBDATASHEETS 

 Discussion 
Subdatasheets are datasheets nested in the primary table and display the data in joined 
tables. When you join tables in a one-to-many relationship, Access creates 
subdatasheets in the table containing the primary key. 
 
When tables are joined, Access inserts a column containing plus signs to the left of the 
first field in the primary table. Clicking the plus sign expands a subdatasheet with the 
data in the related table displayed. If the table contains additional joins, you can 
expand subdatasheets to display each related table. Access can display up to eight 
levels of subdatasheets. 
 
In addition to viewing data, you can edit data right in the subdatasheet; the edited data 
is saved back to the table in which it is stored. 

 
Displaying subdatasheets 

 
  

 
Access can also create subdatasheets for one-to-one 
relationships. 

  

 
If Access cannot determine which subdatasheet to display, the 
Insert Subdatasheet dialog box opens so that you can select the 
table you want to view. In addition, you can select a different 
subdatasheet from the Insert Subdatasheet dialog box at any 
time by selecting the Insert menu and the Subdatasheet 
command. 
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 Procedures 

1. Open the primary table in Datasheet view. 

2. To display a subdatasheet, click the plus sign next to the record you 
want to expand. 

3. Display additional subdatasheets, if available. 

4. Click the minus sign next to any subdatasheet you want to collapse. 

 

DELETING A JOIN LINE 

 Discussion 
Deleting a join line removes the relationship between two tables. You may want to 
delete a join line if you no longer need to relate the tables or you want to create a 
different relationship. 
 
You must select a join line before you can delete it. 
 

  

 
You must click the middle segment of a join line in order to 
select it; clicking the beginning or ending segment does not 
select the join line. 

  

 
You can also delete a join line by right-clicking its middle 
segment and selecting the Delete command. 

  

 
You can remove an unrelated field list from the Relationship 
window by selecting it and pressing the [Delete] key. 

  
 

 Procedures 

1. Open the Relationships window. 

2. Click the middle segment of the join line you want to delete. 

3. Press [Delete]. 

4. Select Yes. 

 



 

 

LESSON 5 -  
WORKING WITH INDEXES  

In this lesson, you will learn how to: 

• View indexes  

• Create a single field index  

• Create a multiple field index  

• Delete an index  

• Create a multiple field primary key  
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VIEWING INDEXES 

 Discussion 
You can use indexes to help Access perform quicker sorts and searches. You should 
index the fields you use regularly to sort or search for data. 
 
Indexes have important properties that are listed in the following table: 

 
Property Description 
Primary Designates whether or not the index is the primary key 

for the table. In other words, this property designates 
whether or not the data in the indexed field will be 
used to uniquely identify each record. If this property 
is set to Yes, the Unique property must be set to Yes. 

Unique Designates whether or not the values in the indexed 
field must be unique for each record. You can set this 
property to Yes without setting the Primary property 
to Yes. 

Ignore Nulls Determines whether or not records with null values in 
the indexed field are included in the index. The default 
setting is No, which means that null values are 
included. 

 

 
The Indexes window 
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You can also display the Indexes dialog box by selecting the 
View menu and then selecting the Indexes command when a 
table is open in Design view. 

  

 
You cannot create an index for Memo, OLE, or Hyperlink 
fields. 

  

  
If there are a limited number of different values in a field, then 
indexing the field does not noticeably speed up searches and 
sorts. In fact, it may slow down data entry and editing. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the table in Design view. 

3. Click the Indexes button  on the Table Design toolbar. 

 

CREATING A SINGLE FIELD INDEX 

 Discussion 
You should index at least one field for each table to maximize performance. You 
should select a field you are likely to use in searches and sorts. 
 
When you change the Indexed property of a field to Yes, you can choose whether or 
not to allow duplicates. If you choose the No Duplicates option, Access will not allow 
duplicate values to be entered into the field. 
 

 Procedures 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field you want to index. 

4. Select the Indexed property. 
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5. Select the Indexed list. 

6. Select the desired indexing option. 

 

CREATING A MULTIPLE FIELD INDEX 

 Discussion 
If you often search on a combination of fields, you can create an index on multiple 
fields to speed up the searches and sorts. For example, if you want to sort customers in 
order by region and alphabetically within each region, you can create an index on the 
Region and Customer fields. 
 
You must create a multiple field index in the Indexes window. All the fields you want 
to include in the index should be listed under the same index name. You can include 
up to ten fields in an index. 
 

 Procedures 

1. Open the desired database. 

2. Open the table in Design view. 

3. Click the Indexes button  on the Table Design toolbar. 

4. Select the first blank field in the Index Name column. 

5. Type the name of the index. 

6. Press [Tab]. 

7. Select the Field Name list. 

8. Select the field you want to index. 

9. Press [Tab]. 

10. Select the Sort Order list. 

11. Select the desired sort order. 

12. Select the next blank field in the Field Name column. 

13. Select the Field Name list. 

14. Select the field you want to index. 

15. Press [Tab]. 
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16. Select the Sort Order list. 

17. Select the desired sort order. 

18. Close the Indexes window. 

 

DELETING AN INDEX 

 Discussion 
Indexes take up disk space and can slow down the process of adding, editing, and 
deleting records. In fact, if there are a limited number of different values in a field, the 
sort or search speed is not significantly increased by indexing the field. Therefore, you 
can delete any unwanted indexes to increase efficiency. 
 

 Procedures 

1. Open the desired database. 

2. Open the table in Design view. 

3. Click the Indexes button  on the Table Design toolbar. 

4. Point to the row selector to the left of the row containing the index 
you want to delete. 

5. Click the row selector to the left of the row containing the index you 
want to delete. 

6. Press [Delete]. 

 

CREATING A MULTIPLE FIELD PRIMARY KEY 

 Discussion 
There are times when it is not possible to uniquely identify fields with the values in a 
single field. Therefore, Access allows you to create a primary key using multiple 
fields. 
 
When you set a primary key using multiple fields, the combination of the information 
in the fields must be unique. For example, you have a table that contains line items for 
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customer orders. The order number is entered for each customer. Because you will 
most likely have multiple customers with multiple orders, the order number associated 
with each customer may not be unique. Also, a particular item number may appear in 
multiple orders. Therefore, the item numbers may not be unique. Thus, you cannot 
create a primary index on either of these fields by themselves. The solution is to create 
a primary key index on both fields, which allows each item to appear only once on 
each order. 

 
Creating a multiple field primary key 

 

 Procedures 

1. Open the desired database. 

2. Open the table in Design view. 

3. Point to the row selector to the left of the row containing the first 
field for the primary key. 

4. Click the row selector to the left of the row containing the first field 
for the primary key. 

5. Hold the [Ctrl] key and point to the row selector for the second 
primary key field. 

6. Click the row selector for the second primary key field and release 
the [Ctrl] key. 

7. Click the Primary Key button  on the Table Design toolbar. 

 



 

 

LESSON 6 -  
CREATING BASIC FORMS  

In this lesson, you will learn how to: 

• Use forms  

• Use the Form Wizard  

• View records in a form  

• Print records in a form  

• Base a form on a query  

• Use AutoForm  

• Add a record using a form  
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USING FORMS 

 Discussion 
Forms, like datasheets, can be used for viewing and editing data. However, they can 
also be used to present data in a more attractive format. Forms are usually designed to 
display all the fields for a single record within the form window, eliminating the need 
to scroll. You can also display data from related tables in one form. 
 
Access provides six basic types of forms: columnar, tabular, datasheet, justified, 
PivotTable and PivotChart. In a columnar form, the field names are listed on the left 
side of the form and the field values appear in a column on the right. If space permits, 
there can be more than one column. 
 
In a tabular form, the field names are listed across the top of the form and the values 
appear in the corresponding columns beneath them. A datasheet form appears similar 
to Datasheet view. Both the tabular and datasheet forms display data in a table layout. 
 
In a justified form, the field names and values appear in alternate rows, evenly spaced 
across the page. Field values appear under the corresponding field names. 
 
A PivotTable form allows you to quickly create a form by dragging fields as desired 
in PivotTable view. Similar to a PivotTable form, a PivotChart form allows you to 
create a chart or graph by dragging fields as desired in PivotChart view. 
 

USING THE FORM WIZARD 

 Discussion 
You can use the Form Wizard to quickly and easily create a form. The Form Wizard 
guides you through the process. First, you must choose the table or query on which 
you want to base the form, and then you can select the fields you want to include. 
Next, you select the desired type of form layout: columnar, tabular, datasheet, 
justified, PivotTable, or PivotChart. You can then select a style from a variety of 
predefined styles provided by Access. Finally, you must name the form. 
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The Customer Data Entry form 

 
  

 
If you base a form on multiple tables, the tables must all be 
related. In addition, the Form Wizard will prompt you to select 
how you want to group the fields on the form. 

  

 
You can also activate the Form Wizard by double-clicking the 
Create form by using wizard option in the Forms object list 
in the Database window, by selecting the Insert menu and the 
Form command, or by clicking the New Object button on the 
Database toolbar and selecting the Form command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Form Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the form. 

7. Add the desired fields to the Selected Fields list box, or add all the 
fields. 

8. Select Next >. 

9. Select the desired form layout. 

10. Select Next >. 
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11. Select the desired form style. 

12. Select Next >. 

13. Type the desired form name. 

14. Select Finish. 

 

VIEWING RECORDS IN A FORM 

 Discussion 
Navigating records in a form is similar to navigating records in Datasheet view. You 
can use the navigation buttons at the bottom of the window to display records in a 
form. The following navigation buttons are available in Form view: 

 
Button Description 

 Displays the first record 

 Displays the previous record 

 Displays the next record 

 Displays the last record 

 
 

  

 
You can also press the [Ctrl+Home] key combination to 
display the first record, the [Ctrl+End] key combination to 
display the last record, and the [Page Up] and [Page Down] 
keys display the previous and next records, respectively. 

  

 
You can also go directly to a record by selecting the number in 
the Record box (located within the navigation buttons at the 
bottom of the window), typing the number of the record you 
want to display, and pressing the [Enter] key. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open a form in Form view. 
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3. Click the Last Record button  at the bottom of the form 
window. 

4. Click the First Record button  at the bottom of the form 
window. 

5. Click the Next Record button  at the bottom of the form 
window. 

6. Click the Previous Record button  at the bottom of the form 
window. 

 

PRINTING RECORDS IN A FORM 

 Discussion 
You can print an open form. 
 
If you use the Print button to print all the data, Access fits as many whole forms as 
possible on each page; Access will not break a form in the middle. If a form is large 
and there are numerous records in it, you may be using a large amount of paper and 
printer time. 
 
If you use the Print dialog box, you can print all records, only specified pages, or all 
selected records, thereby saving time and paper. 
 

  

 
You can also open the Print dialog box by right-clicking an 
object in the Database window and selecting the Print 
command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open a form in Form view. 

3. Select the File menu. 

4. Select the Print command. 

5. Select the desired options. 
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6. Select OK. 

 

BASING A FORM ON A QUERY 

 Discussion 
Forms can extract information from a query as well as from a table. 
 
If the query recordset cannot be updated, you will not be able to edit the form or add 
records to it. Nevertheless, a form can be used to present query data in a more 
attractive manner. 
 

  

 
You can also activate the Form Wizard by double-clicking the 
Create form by using wizard option in the Forms object list 
in the Database window, by selecting the Insert menu and 
then selecting the Form command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Form command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Form Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the query on which you want to base the form. 

7. Add the desired fields to the Selected Fields list box, or add all the 
fields. 

8. Select Next >. 

9. Select the desired form layout. 

10. Select Next >. 

11. Select the desired form style. 

12. Select Next >. 
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13. Type the desired form name. 

14. Select Finish. 

 

USING AUTOFORM 

 Discussion 
The fastest way to create a form is to use AutoForm. AutoForm automatically creates 
a simple columnar, tabular, datasheet, PivotTable, or PivotChart form from the 
selected table or query, without needing any input. However, you must select a table 
or query before AutoForm can create the form. All fields in the table or query will 
appear on the form, and the title of the form is the name of the table or query. 
 
AutoForm does not save the form for you automatically. When you close the form for 
the first time, Access prompts you to save it. 
 

  

 
AutoForm creates a form using the defaults for the selected 
form type. After AutoForm has created a form, however, its 
formatting can be modified in Design view. 

   

 
You can also use AutoForm to create a form based on the 
selected table or query by selecting the Insert menu and the 
AutoForm command or by clicking the New Object button 
on the Database toolbar and selecting the AutoForm 
command. When you use one of these methods, the form 
always appears in a standard columnar format. 

  

 
AutoForm can also be used to produce a formatted columnar 
or tabular report. 

  
 

 Procedures 

1. Select the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select the desired AutoForm option. 

4. Select the Choose the table or query where the object’s data 
comes from list. 
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5. Select the desired table or query. 

6. Select OK. 

 

ADDING A RECORD USING A FORM 

 Discussion 
Forms are frequently used to add records to one or more tables. It can be easier to 
work in a well-designed form than in the underlying table because forms are usually 
designed to display all the fields for a single record within the form window, 
eliminating the need to scroll. 
 
You can use the [Enter] key to move between fields as you enter data. If you want to 
skip one or more fields, you can press the [Tab] key until the insertion point appears 
in the desired field, or you can click in the field in which you want to enter data. 
When you press the [Enter] key after entering data in the last field in a record, Access 
automatically saves the record and displays a blank form for entering another record. 
 

  

 
You can use the [Shift+Tab] key combination to move to the 
previous field. 

  

 
You can also use the New Record button on the Form View 
toolbar to add a record to a form. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open the form in Form view. 

3. Click the New Record button  at the bottom of the window. 

4. Type the desired data into the first field of the new record. 

5. Press [Enter]. 

6. Enter data in additional data into the remaining fields as desired. 

 



 

 

LESSON 7 -  
USING DESIGN VIEW  

In this lesson, you will learn how to: 

• Hide the ruler  

• Disable the Snap to Grid feature  

• Display the field list  

• Add a field  

• Move part of a paired control  

• Align controls  

• Space controls  

• Use the toolbox  

• Add a label  

• Add an image  

• Add a rectangle  

• Add a line  

• Edit an unbound control  

• Use multiple Undo/Redo in Design view  
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HIDING THE RULER 

 Discussion 
You can hide or display the ruler in Design view. The ruler provides two scales in the 
Design window, one across the top and one down the left side. These scales are useful 
when you want to create controls that are a specific size or place controls in a specific 
location. 
 
When you move objects, the appropriate area on the ruler is highlighted. This 
highlighted area indicates the size and position of the control. 
 

  

 
The Ruler command on the View menu acts as a toggle. If 
there is a check mark next to it, the ruler is displayed. 

  

 
You can also hide or display the ruler by right-clicking in the 
Design window and then selecting the Ruler command. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the View menu. 

3. Select the Ruler command. 

 

DISABLING THE SNAP TO GRID FEATURE 

 Discussion 
Access provides several features to help you size and position controls on a form. 
 
The grid in Design view is a series of small points and lines in the Design window. 
These points and lines (gridlines) help you position controls. When the Snap to Grid 
feature is activated, all controls added to the view are automatically positioned on grid 
points. Both the Grid and Snap to Grid features are enabled by default and can be 
disabled as desired. 
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You can also hide or display the grid by right-clicking in the 
Design window and then selecting the Grid command. 

  

 
Both the Grid and the Snap to Grid commands are toggles. If 
there is a checkmark next to either of these commands, the 
command is activated. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the View menu. 

3. Select the Grid command. 

4. Select the Format menu. 

5. Select the Snap to Grid command. 

 

DISPLAYING THE FIELD LIST 

 Discussion 
If a form or report is based on a table or query, you can display its field list. This 
option allows you to easily add fields to the view. 
 
The field list appears as a box that “floats” above Design view. “Floating” means that 
you can drag the field list by its title bar to reposition it anywhere on the screen. This 
option allows you to move the field list to a more convenient location while you work. 
 

  

 
The Field List button acts as a toggle. You click it to display 
the field list and click it again to close the field list. You can 
also close the field list by clicking the Close button on the title 
bar. 

  

 
You can also hide or display the field list by selecting the 
View menu and then selecting the Field List command. 

  

 
You can also display the Field List by pressing the [F8] key. 
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 Procedures 

1. Open the desired form or report in Design view. 

2. Click the Field List button  on the Form Design toolbar. 

 

ADDING A FIELD 

 Discussion 
When you add a field to a form or report, you add both a bound and an unbound 
control. The bound control is a text box that displays the data from the table. The 
unbound control is a label that contains the field name. 
 
When you add a field, the mouse pointer changes into a small box. This box indicates 
where the top left corner of the bound control will appear on the form. The unbound 
control, by default, will be located to the left of the bound control. 

 
Adding a field 

 
  

 
If you move the bound control too close to the left margin, the 
unbound control may not be totally visible. 

  

 
You can also add a field from the Field List to a form or 
report in Design view by selecting the field and pressing the 
[Enter] key. You will then need to move the controls to the 
desired location. 
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 Procedures 

1. Open the desired form or report in Design view. 

2. Display the field list. 

3. In the field list, select the name of the field you want to add to the 
form or report. 

4. Drag the field name to the desired location on the form or report. 

 

MOVING PART OF A PAIRED CONTROL 

 Discussion 
A bound and an unbound control can be paired. When you select a bound control, the 
unbound control is selected. An example is a field text box (the bound control) and its 
label (the unbound control). You can reposition these controls as a single unit, or you 
can reposition them individually. 
 
When you select paired controls, a larger move handle appears in the upper left corner 
of both the bound and unbound controls. You use these handles to move the controls 
individually. 

 
Moving part of a paired control 

 

 Procedures 

1. Open the desired form or report in Design view.  

2. Select the control you want to move. 



Lesson 7 - Using Design View Access 2002 - Lvl 2 

Page 70 Organizational & Staff Development, U of T
 

3. Point to the large move handle in the upper left corner of the control 
you want to move. 

4. Drag the selected control to the new location. 

 

ALIGNING CONTROLS 

 Discussion 
You can automatically align controls with one another. This option allows you to line 
up the edges of controls quicker and more accurately than lining them up individually. 
 
The available alignment options are listed in the following table: 

 
Option Description 
Left The left edges of the controls are aligned with the left edge 

of the leftmost control in the selection. 
Right The right edges of the controls are aligned with the right 

edge of the rightmost control in the selection. 
Top The top edges of the controls are aligned with the top edge 

of the top control in the selection. 
Bottom The bottom edges of the controls are aligned with the 

bottom edge of the bottom control in the selection. 
To Grid The controls are aligned with the grid. 

 
 

  

 
The Align command on the Format menu does not overlap 
controls. Instead of overlapping controls, Access positions 
them with the edges together. 

  

 
You can also align controls by right-clicking in the Design 
window, pointing to the Align command, and then selecting 
the desired command. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the controls you want to align. 
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3. Select the Format menu. 

4. Point to the Align command. 

5. Select the desired alignment command. 

 

SPACING CONTROLS 

 Discussion 
You can increase or decrease the spacing between selected controls, or space them 
evenly between the top and bottom controls. You can also implement spacing changes 
horizontally or vertically. 
 

  

 
When you are spacing controls, you can select the Format 
menu and then select the Increase and Decrease commands to 
increase or decrease the space between objects by one pixel. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the controls you want to space. 

3. Select the Format menu. 

4. Point to the Horizontal Spacing or Vertical Spacing command. 

5. Select the desired spacing command. 

 

USING THE TOOLBOX 

 Discussion 
The toolbox contains tools for adding different kinds of controls to a form or report. It 
appears in Design view by default and “floats” so that you can move it to a more 
convenient location while you work. 
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You can make the toolbox a toolbar by double-clicking its title bar. Once it appears as 
a toolbar, you can make it a floating palette by double-clicking an empty space on the 
toolbar. You can also drag the borders of the toolbox to resize and reshape it. 
 

  

 
If the toolbox does not automatically appear in Design view, 
you can display it by selecting the View menu and then 
selecting the Toolbox command, by clicking the Toolbox 
button on the Report Design toolbar, or by right-clicking in 
the Design window and then selecting the Toolbox command. 

  

 
A tool in the toolbox is automatically disabled after it is used. 
Double-clicking a tool leaves it enabled for multiple uses. You 
can disable the tool by clicking it again. 

  

 
Many tools in the toolbox start control wizards. You can 
deactivate the Control Wizards button to insert one of these 
controls without starting the wizard. The control is then 
inserted with its default settings. 

  
 

ADDING A LABEL 

 Discussion 
You can add text to a form or report. Text usually takes the form of a label and is not 
bound to a field. Labels can be used for data entry instructions on a form or for 
identifying groups of controls on a report. 
 
When you use the Label tool, the mouse pointer changes into the letter A with a plus 
sign (+) above and to the left of it. The center of the plus sign (+) indicates the 
position of the top left corner of the label control. 
 
Access automatically word-wraps the text in a label box as more text is entered. If you 
drag to create a label box, the width of the box remains fixed, while the height 
expands to accommodate additional text. If you click to create a label box, the width 
of the box expands automatically as you enter text. 
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Adding a label in Design view 

 

 Procedures 

1. Open the desired form or report in Design view. 

2 Display the toolbox. 

3. Click the Label tool  in the toolbox. 

4. Click in the form or report where you want the top left corner of the 
label to appear. 

5. Type the text for the label. 

6. Press [Enter]. 

 

ADDING AN IMAGE 

 Discussion 
You can add a control to a form or report that contains an image. The image is 
unbound and usually added only for aesthetics. Images can be any type of graphic file. 
If a graphic file is too large to fit in the frame of the control, the entire graphic will not 
appear. However, you can resize the frame to display more of the image. 
 
When you activate the Image tool in the toolbox, the mouse pointer changes into a 
copy of the tool with a plus sign (+) above and to the left of it. As you drag to draw 
the frame of the control, the center of the plus sign (+) indicates the position of the top 
left corner of the frame. 
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Adding an image in Design view 

 

 Procedures 

1. Open the desired form or report in Design view. 

2. Display the toolbox. 

3. Click the Image tool  in the toolbox. 

4. Drag to draw a frame for the control in the form or report. 

5. Select the Look in list. 

6. Select the drive where the image is stored. 

7. Select the folder where the image is stored. 

8. Select the desired image. 

9. Select OK. 

 

ADDING A RECTANGLE 

 Discussion 
You can draw a rectangle on a form or report. Rectangles can enhance areas of a form 
or enclose controls. 
 
When you use the Rectangle tool in the toolbox, the mouse pointer changes into a 
rectangle with a plus sign (+) above and to the left of it. As you drag to draw the 
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rectangle, the center of the plus sign (+) indicates the position of the top left corner of 
the rectangle. 

 
Adding a rectangle in Design view 

 

 Procedures 

1. Open the desired form or report in Design view. 

2. Display the toolbox. 

3. Click the Rectangle tool  in the toolbox. 

4. Drag to draw a rectangle in the form or report. 

 

ADDING A LINE 

 Discussion 
You can draw a line on a form or report. Lines can enhance forms and reports by 
separating particular areas. For example, you can add a line to a report that separates 
groups of information. 
 
When you use the Line tool in the toolbox, the mouse pointer changes into a slanted 
line with a plus sign (+) above and to the left of it. As you drag to draw the line, a line 
extends from the center of the plus sign (+). 
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A line added to Form view 

 
  

 
You can ensure that you draw a straight line by holding the 
[Shift] key while you drag in the form or report. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Display the toolbox. 

3. Click the Line tool  in the toolbox. 

4. Drag to draw a line in the form or report. 

 

EDITING AN UNBOUND CONTROL 

 Discussion 
You can edit text in an unbound control (i.e., a label). However, you must be in edit 
mode. In edit mode, the insertion point and a solid background appear in the unbound 
control. You cannot edit text while the sizing handles are displayed. Also, deleting all 
the label text does not delete the control. 
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 Procedures 

1. Open the desired form or report in Design view. 

2. Select the unbound control you want to edit. 

3. Click to position the insertion point in the text. 

4. Type the desired changes. 

5. Press [Enter]. 

 

USING MULTIPLE UNDO/REDO IN DESIGN VIEW 

 Discussion 
The Undo feature allows you to reverse the results of the previous command or 
action. 
 
Once you have used the Undo feature, the Redo feature becomes available. The Redo 
feature allows you to restore the results of the command or action you reversed with 
the Undo feature. Both features can be accessed on the Form Design or Report 
Design toolbar or from the Edit menu while working in Design view. 
 
When you work with Access object types, such as tables, queries, forms, or reports, in 
Design view, you can also use the list arrow on the Undo or Redo button to undo or 
redo multiple actions. This feature is useful if you want to reverse a previous action, 
but have performed a number of actions subsequent to it. When you select an action to 
undo or redo, however, all the items performed after the selected action in the list are 
also reversed or redone. 
 
However, when you open a table or query in Datasheet view, you are limited to 
undoing one action at a time. Each time you choose the Undo button in Datasheet 
view, the last action performed is reversed. When all actions have been undone, the 
Undo button becomes grayed out. The redo feature is not available in Datasheet 
view. 
 
A feature related to Redo is the Repeat feature, which is only available from the Edit 
menu while working in Design view. You can use the Repeat feature to duplicate the 
previous action. 
 
The task to be undone or redone appears as part of the Undo and Repeat commands. 
For example, if you have just deleted text, the Undo Delete command would appear 
on the Edit menu. 
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You can also undo and redo actions by selecting the Edit 
menu and then the Undo or Redo command. The action to be 
undone or redone appears as part of the command. 

  

 
Multiple undo and redo is also available when working with 
data access pages, macros, and modules. 

  
 

 Procedures 

1. To undo the previous command or action, click the Undo button 

 on the Standard toolbar. 

2. To redo the undone command or action, click the Redo button  
on the Standard toolbar. 

3. To undo or redo multiple consecutive actions, click the Undo or 
Redo button arrow, as applicable. 

4. Select the action you want to undo or redo. 

 



 

 

LESSON 8 -  
MANIPULATING CONTROLS  

In this lesson, you will learn how to: 

• Use controls  

• Select non-adjacent controls  

• Select adjacent controls  

• Delete controls  

• Size a control by dragging  

• Move controls  

• Size controls automatically  

• View the properties of an object  

• Change a control property  
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USING CONTROLS 

 Discussion 
When you create forms or reports in Design view, you work with controls. Controls 
are objects in a form or report that contain information. Forms and reports usually 
include bound text box controls and unbound label controls. 
 
Text box controls display data from fields in a table or query on which a form or 
report is based. Text boxes are also used as entry fields for data in a form. Text boxes 
are known as bound controls because the source of the data is stored in a specific field 
in a table. 
 
When you add a control to a form, you decide where the control gets the information 
it displays. For example, a bound text box control can be added that displays a name 
from the Name field in an address table. The bound text box control gets the values 
from the Name field because you have connected or bound it to that field. 
 
Label controls are unbound controls. They display information that is not stored in a 
table. Unbound controls can be text, images, lines, or rectangles drawn on the design. 
Unbound controls are often paired with bound controls as labels. Unbound controls 
are also used to enhance a form or report, or to provide more information, such as 
instructions for entering data. 
 
Text box and label controls are automatically added to a form created using the Form 
wizard. However, you can use the toolbox in Design view to add other controls to a 
form or report. These controls include list boxes, combo boxes, drop-down list boxes, 
command buttons, check boxes, option buttons, option groups, toggle buttons, and 
tabs. 
 

  

 
Calculated controls derive their information using an 
expression to manipulate the table data on which a form is 
based. For example, you can display an order total on a form 
that is calculated by multiplying the Unit Price and the 
Quantity fields in an Orders table. Calculated controls are 
unbound since the result of the calculation is not stored in a 
table. 
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SELECTING NON-ADJACENT CONTROLS 

 Discussion 
Controls are the building blocks of a form or report. In order to make any changes to 
an element of a form or report, you must select the control that defines the element. 
When a control is selected in Design view, sizing handles appear. Sizing handles are 
boxes on the corners and sides of the control. The large box that appears in the upper 
left corner of a control is a move handle. Move handles are used to move an individual 
control without moving any other controls, even if they are selected. 
 
When you select controls, you should be aware that bound controls are often paired 
with unbound controls. For example, a bound control (i.e., a text box) in a table often 
has an unbound control (i.e., a label) next to it containing the field name. When you 
select the bound control, the unbound control is also selected and is affected by the 
next operation. However, when you select the unbound control, the bound control is 
not selected and is unaffected by the next operation. 

 
Selected non-adjacent controls 

 
  

 
When you open a form or report in Design view for the first 
time, the toolbox appears. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Click the first control you want to select. 
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3. Hold [Shift], click any additional controls, and release [Shift]. 

 

SELECTING ADJACENT CONTROLS 

 Discussion 
By selecting controls in Design view, you are telling Access what elements should be 
affected by the next command or operation you perform. You can select multiple 
controls to be affected by the next command or operation, rather than selecting each 
control individually. If the controls are adjacent to one another, you can select the 
controls by dragging a rectangle around them. 
 
When multiple controls are selected, sizing and move handles appear around each 
control. 

 
Selected adjacent controls 

 
  

 
If the ruler is displayed, you can drag in it to select multiple 
adjacent controls. 

  

 
You can select all controls by selecting the Edit menu and 
then selecting the Select All command. 
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Make sure that the mouse pointer does not change into a black 
hand when you begin to drag a selection box. If it does, you 
will end up moving the control instead of selecting multiple 
controls. If you move a control by mistake, use the Undo 
feature to reverse the action. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Point to a blank area just above and to the left of the first control you 
want to select and drag down and to the right to create a box around 
the desired controls. 

 

DELETING CONTROLS 

 Discussion 
You can delete controls from Design view. When you delete a bound control, you do 
not delete the field in the table or the data it contains; rather, you keep the data from 
being displayed in the form or report. 
 

  

 
You can select the Edit menu and then select the Undo Delete 
command or click the Undo button to restore a control you 
have just deleted. However, you cannot restore a deleted 
control after you have saved the form or report design. 

  

 
You can also delete a control by selecting the Edit menu and 
then selecting the Delete command. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the control(s) you want to delete. 

3. Press [Delete]. 
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SIZING A CONTROL BY DRAGGING 

 Discussion 
You can change the size of any control in Design view. Controls that display text 
generally display a single line of text horizontally and are long enough to show the 
entire data entry. If a control is not large enough to display the entire data entry to 
which it is bound, you have to scroll the corresponding field in form view to see the 
entire entry. If a field contains a large amount of text, such as a memo field, you can 
display several lines of text in the field by vertically increasing the size of the bound 
control. Changing the size of the control does not change the size of the text it 
contains. 
 

  

 
You can size selected controls with the keyboard by holding 
the [Shift] key while pressing the [Up], [Down], [Left], or 
[Right] arrow keys. The selected controls are sized one pixel 
at a time. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the control(s) you want to size. 

3. Point to the desired sizing handle. 

4. Drag the sizing handle in the desired direction to expand or contract 
the control. 

 

MOVING CONTROLS 

 Discussion 
You can move a paired bound and unbound control (i.e., a field text box and its label) 
as a single unit to any location in a form or report in Design view. When you move 
one control in a pair, its corresponding control automatically moves along with it. 
Moving controls can improve the appearance and efficiency of forms and reports. The 
controls must be selected before you can move them. 
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If you want to move both the bound and unbound controls as a single unit, be careful 
that you do not drag a control by either of the large move handles in the upper left 
corner of the selected controls. If you do, the mouse pointer changes into a pointing 
hand instead of an open hand and the paired bound and unbound controls are moved 
individually, rather than as a single unit. 
 

  

 
You can move selected controls with the keyboard by pressing 
the [Up], [Down], [Left], or [Right] arrow keys. The selected 
objects move to the next grid point. Holding the [Ctrl] key 
while dragging temporarily suspends the Snap to Grid feature 
and allows you to freely position a control. 

  

 
To move a control while keeping it in the same horizontal or 
vertical position, hold down the [Shift] key and click the 
control, and then drag the control by its move handle either 
horizontally or vertically. The first direction you drag 
determines which position will be maintained. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the control(s) you want to move. 

3. Point to the edge of one of the selected controls. 

4. Drag the controls to the desired location. 

 

SIZING CONTROLS AUTOMATICALLY 

 Discussion 
Design view has formatting commands you can select to size controls automatically. 
You can use these commands to improve the appearance of a form or report by giving 
the display a consistent and orderly look. 
 
The available sizing options are listed in the following table: 

 
Option Description 
To Fit Sizes the controls to fit the contents. 
To Grid Sizes the controls to the grid. 
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Option Description 
To Tallest All selected controls become as tall as the tallest 

control in the selection. 
To Shortest All selected controls become as short as the shortest 

control in the selection. 
To Widest All selected controls become as wide as the widest 

control in the selection. 
To Narrowest All selected controls become as narrow as the 

narrowest control in the selection. 
 

 
Multiple controls resized to the same width 

 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the control(s) you want size. 

3. Select the Format menu. 

4. Point to the Size command. 

5. Select the desired size command. 

 



Access 2002 - Lvl 2 Lesson 8 - Manipulating Controls 

Organizational & Staff Development, U of T Page 87
 

VIEWING THE PROPERTIES OF AN OBJECT 

 Discussion 
Every object in Access has properties that define its characteristics. Database objects, 
such as tables, queries, and forms, have very general properties, such as their name 
and description. Other objects, such as fields in a table or controls on a form, have 
many properties that control their appearance, such as font size and color, the number 
of decimal places, and the control source. You can change the properties of the objects 
on a form or report in Design view using the property sheet. The properties displayed 
on the property sheet depend on what type of object is selected. For example, the 
properties for a label box differ from the properties for the Detail section of a form. 
You can also change the properties for page and form headers and footers. 
 
The properties of objects are grouped into five categories: 

 
Category Description 
Format Specifies the appearance of objects, such as the font 

characteristics, position and size of a text box or whether 
or not scroll bars appear on a form. 

Data Determines the characteristics of the data displayed, such 
as the data’s control source, default value, or whether or 
not it can be edited. You can change the data source for 
an individual control or for the entire form. 

Event Specifies a procedure that Access executes when an event 
occurs. Some examples of events include clicking a 
control (OnClick), deleting data (OnDelete), and opening 
the form (OnOpen). The procedure can be an expression, 
a macro, or a Visual Basic for Access routine. 

Other Shows additional features of the control, such as the 
name of the control or whether or not a control is in the 
tab order. 

All Displays all the properties of the object in one list. 
 
 

  

 
You can also display the property sheet by selecting the View 
menu and then selecting the Properties command or by right-
clicking a form or report in Design view and then selecting the 
Properties command. 

  

 
You can also display the properties sheet by pressing [F4] on 
the keyboard. 
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The name of the selected object appears in the title bar of the 
property sheet and in the Object box on the Formatting 
(Form/Report) toolbar. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the desired object. 

3. Click the Properties button  on the Form Design toolbar. 

4. Select the desired tab on the property sheet. 

 

CHANGING A CONTROL PROPERTY 

 Discussion 
The properties of a control define many of its aspects, including the source of the 
information displayed in the control, its name, if it is displayed or hidden, and its 
appearance (font size, color, size, position, etc.). Properties of controls and other 
objects can be easily changed to suit your needs. For example, you may have a form 
with records you want to keep constant. You can select No in the form’s Allow Edits 
property box to prevent any editing of the records. The property sheet also allows you 
to precisely position and size a control. 

 
The Format page of the property sheet 
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You can change the properties of several controls at once. For 
example, you can select several text boxes and change the font 
type and size for all of them at the same time, rather than 
individually. 

  

 
You can also open the property sheet by double-clicking a 
label or text box on the form. 

  
 

 Procedures 

1. Open the desired form or report in Design view. 

2. Select the desired control. 

3. Click the Properties button  on the Form Design toolbar. 

4. Select the desired tab on the property sheet. 

5. Select the desired property you want to set. 

6. Select the list for the property, if appropriate. 

7. Type the desired property setting or choose a property setting from 
the list. 

8. To modify another control, click the desired control on the form. 

9. Change the control properties as desired. 

10. Click the Close button to close the property sheet. 

 



 

 

LESSON 9 -  
USING ADVANCED FORM DESIGN  

In this lesson, you will learn how to: 

• Use forms in Design view  

• Create a combo box  

• Create a list box  

• Create an option group  

• Add a logic control  

• Set the tab order automatically  

• Set the tab order manually  

• Add a form header and footer  

• Create a blank form  
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USING FORMS IN DESIGN VIEW 

 Discussion 
You can create or customize a form in Design view. A form has three basic sections: 
Detail, Form Header/Footer, and Page Header/Footer. 
 
The Detail section contains the information from the table or query. You create 
controls in the Detail section that allow you to display or enter information. Access 
provides a variety of control types you can add to the form to simplify the data entry 
process. For example, you can replace a text box with a list box or an option group so 
that you can select a value rather than type it during data entry. In many cases, it is 
quicker and easier to select a value from a list rather than to remember the value you 
want to use and then type it. Having a list of choices also helps to ensure the 
consistency of the data being entered. 
 
The Form Header and Form Footer sections display at the top and bottom of a form 
in Form view. They are stationary when you scroll the Detail section, making them 
useful for displaying titles or instructions you want visible on the form at all times. If 
you print the form, these sections appear at the top of the first page and at the bottom 
of the last page. You can also place controls, including images, labels, and fields in 
the form header or footer. 
 
The Page Header and Page Footer sections display at the top and bottom of the form 
in Design view. They do not appear in Form view. Rather, they display at the top and 
bottom of every page when the form is printed. Page headers and footers can contain 
images, lines, and text, or any other controls you want printed on every page. 
 
When you enable the display of either the page or form header/footer section, both the 
header and the footer appear. You can drag the header and footer sections to resize 
them. 
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A form with form and page headers and footers in Design view 

 

CREATING A COMBO BOX 

 Discussion 
You can create a combo box on a form. A combo box provides you with a list of 
values from which you can choose. Choosing from a list is much faster and more 
accurate than remembering a value to be typed. However, you can also type a value 
directly into a combo box if the appropriate value is not available from the list. 
 
A combo box can be bound to a field, meaning that when you select or enter a value, 
that value is entered into that field in the corresponding table. A combo box can also 
be unbound, meaning that when you select or enter a value, it is held in memory to be 
used in another control or calculation. 
 
Access provides a Combo Box Wizard that guides you through the process of creating 
a combo box. You can select the list of values from an existing table or query, or you 
can create the values for the list yourself. If you choose to select the list from an 
existing table or query, the wizard prompts you to enter the table or query and the 
field name. If you choose to create the list of values yourself, the wizard displays a 
column for the entries. Either way, once the values are entered into the wizard, you 
then specify whether the values should be entered into a field in the table or held in 
memory for later use. You complete the combo box by entering a label. 
 
When you use the Combo Box tool, the mouse pointer changes into a copy of the tool 
with a plus sign (+) above and to the left of it. 
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A combo box added to a form 

 

 Procedures 

1. Open the desired form in Design view. 

2. Display the toolbox. 

3. Click the Combo Box tool  in the toolbox. 

4. Click in the form in the location where you want the combo box to 
appear. 

5. Select the desired option for the source of the combo box values. 

6. Select Next. 

7. Select the desired view option. 

8. Select the table or query containing the values for the combo box in 
the Which table or query should provide the values for your 
combo box? list box. 

9. Select Next. 

10. Select the field containing the values from the Available Fields list 
box. 

11. Select Next. 

12. Select Next. 
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13. Select the desired storage option for the field. 

14. Select the Store that value in this field list, if applicable. 

15. Select the desired field name, if applicable. 

16. Select Next. 

17. Type a label for the combo box. 

18. Select Finish. 

 

CREATING A LIST BOX 

 Discussion 
You can create a list box on a form. A list box provides you with a list of values from 
which you can choose. Choosing from a list is much faster and more accurate than 
remembering a value to be typed. However, unlike a combo box, you can only choose 
an item from the list; values not present on the list cannot be entered into the table. 
 
A list box can be bound to a field, meaning that when you select or enter a value, the 
value is entered into a field in the corresponding table. A list box can also be unbound, 
meaning that when you select or enter a value, it is held in memory to be used in 
another control or calculation. 
 
The List Box Wizard guides you through the process of creating a list box. You can 
select the list of values from an existing table or query, or you can create the values 
for the list yourself. If you choose to select the list from an existing table or query, the 
wizard prompts you to enter the table or query and the field name. If you choose to 
create the list of values yourself, the wizard displays a column for the entries. Either 
way, once the values are entered into the wizard, you then specify whether the values 
should be entered into a field in the table or held in memory for later use. 
 
When you use the List Box tool, the mouse pointer changes into a copy of the tool 
with a plus sign (+) above and to the left of it. The center of the plus sign (+) indicates 
the position of the top left corner of the list box. 
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A list box added to a form 

 
  

 
You can set the default value for a list box by opening the 
property sheet and typing the desired value in quotation marks 
in the Default Value property box on the Data page. 

  
 

 Procedures 

1. Open the desired form in Design view. 

2. Display the toolbox. 

3. Click the List Box tool  in the toolbox. 

4. Click in the form in the location where you want the combo box to 
appear. 

5. Select the desired option for the source of the list box values. 

6. Select Next. 

7. Type the number of columns for the list box. 

8. Press [Tab]. 

9. Type the first value for the list box. 

10. Press [Tab]. 
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11. Continue to type values as desired. 

12. Select Next. 

13. Select the desired storage option for the field. 

14. Select the Store that value in this field list, if applicable. 

15. Select the desired field name, if applicable. 

16. Select Next. 

17. Type a label for the list box. 

18. Select Finish. 

 

CREATING AN OPTION GROUP 

 Discussion 
You can create an option group on a form. An option group provides you with a 
limited set of values from which you can choose. Choosing from a set of values is 
often much faster and more accurate than remembering a value to be typed. With an 
option group, you can only select one option from the set of alternatives. Therefore, 
option groups are best utilized when there are five or less values from which to 
choose. Adding more than five values to an option group can crowd a form and is less 
effective for quick data entry. 
 
An option group has a frame that encloses the set of values. These values appear 
beside option buttons or check boxes, or on top of toggle buttons. 
 
The Option Group Wizard guides you through the process of creating an option group. 
An option group can be bound to a field in a table or query. However, only the frame 
is bound to the field. Within the frame, Access assigns each option a numeric value, 
starting with the number 1. When the option is selected, this numeric value is entered 
into the corresponding field. Access assigns a number because the value of an option 
group cannot be text. For example, if a product comes in three colors (white, black, 
and green), you can use an option group in an order entry form to select the color 
being ordered. By default, Access assigns the number 1 to the White option, the 
number 2 to the Black option, and the number 3 to the Green option. You only see 
the White, Black, and Green options on the form, but Access actually stores the 
assigned numbers in the corresponding field in the table. 
 
When you use the Option Group tool, the mouse pointer changes into a copy of the 
tool with a plus sign (+) above and to the left of it. The center of the plus sign (+) 
indicates the position of the top left corner of the option group. 
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An option group added to a form 

 

 Procedures 

1. Open the desired form in Design view. 

2. Display the toolbox. 

3. Click the Option Group tool  in the toolbox. 

4. Click in the location on the form where you want the option group to 
begin. 

5. Type the desired label for the first option. 

6. Press [Tab]. 

7. Type other labels as desired. 

8. Select Next. 

9. Select the desired option for the default. 

10. Select Next. 

11. Type new values for the labels, if desired. 

12. Select Next. 

13. Select the desired storage option for the field. 

14. Select the Store the value in this field list, if applicable. 
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15. Select the desired field name, if applicable. 

16. Select Next. 

17. Select the desired option for the control type. 

18. Select the desired style option. 

19. Select Next. 

20. Type the caption for the option group. 

21. Select Finish. 

 

ADDING A LOGIC CONTROL 

 Discussion 
Some tables contain fields that have a Yes/No field type. These fields can contain a 
Yes (True) value, a No (False) value, or no value at all. 
 
When working with a form that contains a Yes/No field, you can create a logic control 
that is bound to the Yes/No field. Logic controls give a visual display of the value in a 
Yes/No field, such as a check box where a check mark appears when the field value is 
Yes and does not appear when the value is No. Another type of logic control is the 
toggle button, which appears “sunken” for a value of Yes and “raised” for a value of 
No. The logic control for a field with a null value (neither Yes nor No is chosen) 
appears the same as the field with a No value. 
 
Logic controls improve the visual effectiveness of a form and facilitate data entry. 
With a logic control, the value of a Yes/No field is selected with a single click of the 
mouse button rather than multiple keystrokes. 
 
The way in which the different controls indicate a Yes or No value are described in 
the following table: 

 
Control Appearance 
Toggle button Appears “sunken” with a Yes value and “raised” with 

a No value. 
Option button Contains a dot with a Yes value and appears empty 

with a No value. 
Check box Appears checked with a Yes value and unchecked 

with a No value. 
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 Procedures 

1. Open the desired form in Design view. 

2. Display the toolbox. 

3. Click the desired logic control tool in the toolbox. 

4. Click in the form where you want the logic control to appear. 

5. Click the Properties button  on the Form Design toolbar. 

6. Select the Data tab. 

7. Select the Control Source list. 

8. Select the Yes/No field you want bound to the logic control. 

9. Click the Close button to close the property sheet. 

10. Select the label box of the logic control. 

11. Select the default text. 

12. Type the desired logic control name. 

13. Press [Enter]. 

 

SETTING THE TAB ORDER AUTOMATICALLY 

 Discussion 
The tab order determines the order in which form fields and controls are selected 
when you press the [Tab] key during data entry. The default tab order is the order in 
which the fields or controls were added to the form. If you have added, rearranged, or 
deleted fields or controls, the tab order may not be suitable for data entry. You can 
choose to have Access automatically rearrange the tab order to reflect the order of the 
fields on the form. The fields are then accessed from left to right across each row. 
 

  

 
You can also open the Tab Order dialog box by right-clicking 
in the Design window and then selecting the Tab Order 
command. 
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 Procedures 

1. Open the desired form in Design view. 

2. Select the View menu. 

3. Select the Tab Order command. 

4. Select Auto Order. 

5. Select OK. 

 

SETTING THE TAB ORDER MANUALLY 

 Discussion 
The tab order determines the order in which form fields and controls are selected 
when you press the [Tab] key during data entry. The default tab order is the order in 
which the fields or controls were added to the form. If you have added, rearranged, or 
deleted fields or controls, the tab order may not be suitable for data entry. You can 
adjust the tab order manually to reflect whatever order is best for your data entry 
needs. 
 

 Procedures 

1. Open the desired form in Design view. 

2. Select the View menu. 

3. Select the Tab Order command. 

4. Select the record selector to the left of the field you want to move. 

5. Drag the field to the new position. 

6. Select OK. 
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ADDING A FORM HEADER AND FOOTER 

 Discussion 
The Form Header and Form Footer sections display at the top and bottom of the 
form in Form view. They are stationary when you scroll the Detail section, making 
them useful for displaying titles or instructions you want visible on the form at all 
times. If you print the form, these sections appear at the top of the first page and the 
bottom of the last page. 
 
You can place controls, including images, labels, and fields, in the form header or 
footer. 

 
A label added to the Form Header section 

 
  

 
You can also display the Form Header and Form Footer 
sections by right-clicking in the Design window and then 
selecting the Form Header/Footer command. 

  

 
You can also add Page Header and Page Footer sections to a 
form. Page headers and footers only appear when the form is 
printed. These sections can be added to the form by selecting 
the View menu and then selecting the Page Header/Footer 
command. 

  

 
You can change the height of a section by dragging the bottom 
border of the section up or down. 
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 Procedures 

1. Open the desired form in Design view. 

2. Display the toolbox. 

3. Select the View menu. 

4. Select the Form Header/Footer command. 

 

CREATING A BLANK FORM 

 Discussion 
You can create a form from scratch in Design view. For example, if a form does not 
currently exist for a particular table or query, you can create one using the fields in the 
selected table or query. You can then determine the design of the form by adding 
fields, control, and options. 

 
A form created from scratch 
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 Procedures 

1. Display the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Design View. 

4. Select the Choose the table or query where the object’s data 
comes from list. 

5. Select the table or query on which you want to base the form. 

6. Select OK. 

7. Add items to the form as desired. 

 



 

 

LESSON 10 -  
USING OTHER FORM TECHNIQUES  

In this lesson, you will learn how to: 

• Add a command button  

• Save a form as a report  

• Create a PivotTable or PivotChart view  
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ADDING A COMMAND BUTTON 

 Discussion 
You can design one or more command buttons to appear on a form. These command 
buttons can then be used to access commonly used functions. For example, if you 
frequently use the Calculator, you can create a command button that can simply be 
clicked to instantly access the Calculator. 
 
Command buttons are particularly useful because they do not require the database 
user to know the Microsoft Access menu structure. For example, instead of making 
the user select the Print command from the File menu to print a displayed form, you 
could add the Print function to a command button on the form. 
 
Access provides different actions for you to use, which are available in the following 
categories: Record Navigation, Record Operations, Form Operations, Report 
Operations, Application, and Miscellaneous. 

 
Adding a command button 

 
  

 
If you click the Control Wizards button before you create a 
command button, Access provides you with a wizard that 
helps you create the command button. 
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 Procedures 

1. Open the desired database. 

2. Open the desired form in Design view. 

3. Display the toolbox. 

4. Click the Control Wizards tool  in the toolbox. 

5. Click the Command Button tool  in the toolbox. 

6. Click in the form where you want to insert the command button. 

7. Select the desired category from the Categories list box. 

8. Select the desired action from the Actions list box. 

9. Select Next. 

10. Type the file name of the application you want to run and the path if 
necessary. 

11. Select Next. 

12. Select whether you want text or a picture to display on the button. 

13. Select the text in the Text box or select the desired picture. 

14. Type the text you want to appear on the button, as necessary. 

15. Select Next. 

16. Type the desired name for the button. 

17. Select Finish. 

 

SAVING A FORM AS A REPORT 

 Discussion 
If you have an existing form you print often, you can save the form as a report. It is 
possible to print a form directly, but reports are more suitable for presenting 
information on paper, especially if you need to include group totals. Once a form is 
saved as a report, its structure can be modified in Report Design view to suit your 
needs. 
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You can also open the Save As dialog box by selecting the 
desired form in the Database window, selecting the File menu, 
and then selecting the Save As command. 

  
 

 Procedures 

1. Open the desired database. 

2. Display the Forms object list. 

3. Right-click the form you want to save as a report. 

4. Select the Save As command. 

5. Type a name for the report. 

6. Select the As list. 

7. Select the desired Report or Form item. 

8. Select OK. 

 

CREATING A PIVOTTABLE OR PIVOTCHART VIEW 

 Discussion 
You can view any database form in PivotTable or PivotChart view using the View 
list. In PivotTable view, you can summarize and analyze large amounts of data. 
PivotChart view allows you to display data in a graphical environment. You design a 
PivotTable or PivotChart view by dragging fields from the Field List to preset drop 
areas in the PivotTable or PivotChart view workspace. As an alternative to dragging 
fields, you can also select the desired field in the Field List, select the desired drop 
area from the bottom of the Field List, and then use the Add to button to add the field 
to that field. 
 
In the Field List, fields are listed below a corresponding fieldset. When you expand 
the fieldset, the individual fields are displayed. Field names become bolded when they 
are added to the view workspace. 
 
Once the table or chart is designed, fields can be moved, added, or deleted as desired. 
In addition, you can apply formatting to the items in PivotTable or PivotChart to 
enhance its appearance. You can use options in the property sheet or buttons on the 
Formatting (PivotTable/PivotChart) toolbar to apply formatting. 
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When you create a PivotTable view, Access automatically creates a PivotChart view, 
and vice versa. The PivotTable layout is slightly different than the PivotChart layout, 
however, and may require slight modification. Specifically, when you drag a field into 
the Drop Totals or Detail Fields Here area in a PivotTable, that field is added as a 
detail field which displays the detail but not a summary of the detail. Because of the 
nature of this field, the information will not display on the chart in the data field area. 
In this instance, you will need to add that same field to the data area in PivotChart 
view. The addition is also reflected in the PivotTable. Any formatting applied to items 
in each view, however, is independent of the other view. 
 
PivotTable and PivotChart views are automatically saved and updated as part of the 
layout of the form when you close the form. 
 

  

 
You can also display data in a table or query in PivotTable 
and PivotChart view. 

  

 
If necessary, you can display the Field List by selecting the 
Field List button on the Formatting (PivotTable/PivotChart) 
toolbar, or by right-clicking a blank area of the view 
workspace and selecting Field List. 

  
 

  

 
Changes made in PivotTable or PivotChart view cannot be 
undone. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the desired form. 

3. Select the View list on the Form Design toolbar. 

4. Select PivotTable View or PivotChart View. 

5. Click the Field List button on the PivotTable toolbar. 

6. To add a row or category, expand the fieldset on the Field List 
containing the field you want to drag to the Drop Row Fields Here 
or Drop Category Fields Here area on the view workspace. 

7. Drag the desired field button from the Field List to the Drop Row 
Fields Here or Drop Category Fields Here area. 

8. To add a column or series, expand the fieldset on the Field List 
containing the field you want to drag to the Drop Column Fields 
Here or Drop Series Fields Here area on the view workspace. 
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9. Drag the desired field button from the Field List to the Drop 
Column Fields Here or Drop Series Fields Here area. 

10. To add a totals or a data detail field, expand the fieldset on the Field 
List containing the field you want to drag to the Drop Totals or 
Detail Fields Here or Drop Data Fields Here area on the view 
workspace. 

11. Drag the desired field button from the Field List to the Drop Totals 
or Detail Fields Here or Drop Data Fields Here area. 

12. To add a filter field, expand the fieldset on the Field List containing 
the field you want to drag to the Drop Filter Fields Here area on the 
view workspace. 

13. Drag the desired field button from the Field List to the Drop Filter 
Fields Here area. 

 



 

 

LESSON 11 -  
USING SUBFORMS/SUBREPORTS  

In this lesson, you will learn how to: 

• Work with subforms/subreports  

• Create a subform/subreport  

• Edit the layout of a subform  

• Display a subform in Datasheet view  

• Display a subform total  
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WORKING WITH SUBFORMS/SUBREPORTS 

 Discussion 
You can display a form/report within a form/report. The main form/ report includes 
information from one table and the subform/subreport includes information from a 
second, related table. 
 
You can show a form or report within a form/report to more effectively show the 
linked data from tables with one-to-many relationships. The main form/report and the 
subform/subreport are linked by a common field between the tables. The main 
form/report represents the one side of the one-to-many relationship and the 
subform/subreport represents the many side. When viewing a record in the main 
form/report (one side relationship), the subform/subreport displays the related records 
from another table (many side relationship). For example, you have a Customer table 
and an Orders table. Each customer has several orders. In the Customer form (bound 
to the Customer table), you can include an Orders subform (bound to the Orders 
table). The tables would probably be linked by a Customer ID field; a field present in 
both tables. As you view a customer’s record displayed in the main form, the order 
records of that customer appear in the subform. When you move to the next customer 
record in the main form, the order records in the subform are updated to display that 
customer’s orders. Just as you can manipulate table data in a form, you can also 
manipulate the related table data using the subform. Using the same example, you can 
edit the customer records or the order records. 
 
Subform data can be displayed in either Form view (one record at a time) or 
Datasheet view (many records displayed at once), while subreport data can only be 
displayed in Print Preview. You can also create and display subform data in a 
PivotTable or PivotChart. 
 
You can add any number of subforms/subreports to a form/report as well as add a 
subform/subreport within another subform/subreport. You should keep in mind that 
the purpose of a form/report is to make viewing and entering data easier. You can 
avoid cluttering the form/report (which can cause confusion) by positioning the 
subform(s) or subreport(s) carefully, assigning a different background color to each, 
and removing any unnecessary items, such as scroll bars. Viewing the properties of 
the subform/subreport is helpful when considering these options. 
 
The SubForm/SubReport Wizards provide the easiest method for creating a subform 
subreport. If you choose not to use the SubForm/SubReport Wizards, you will need to 
design a form/report and then insert it into another form/report. You may not want to 
use the wizard if you are designing a subform/subreport that is very different in 
appearance from the form report the wizard produces. 
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CREATING A SUBFORM/SUBREPORT 

 Discussion 
When you add a subform/subreport to an existing form, it is best to start by creating 
the main form/report before you create the subform/subreport. The form/ report can 
then be edited so that it contains only the information you need, as well as the desired 
layout. This form can be added to the design of the main form where it will take on 
the properties of a subform or subreport. 
 
You can create a subform that will appear in Form view, Datasheet view, or both 
views. When the form is created using the SubForm Wizard, a subform is created that 
can be viewed in both Form and Datasheet views. You can customize the subform in 
Design view by adding headers, footers, color, fonts, totals, etc. 
 
The SubForm/SubReport Wizard prompts you for the following information: 

 
1. If you want to use an existing form/report as the subform/subreport 

or build a new one from tables and queries. 

2. If you want to define the link between the main form/report and 
subform/subreport yourself or choose from a list of available link 
options. 

3. A name for the subform or subreport. 
 

 
A subform within a form 
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Although it is not necessary to click the Control Wizards 
button before creating a subform or subreport, it is 
recommended. Clicking this button enables the control 
wizards that assist you in creating a subform or subreport. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the desired form or report in Design view. 

3. Display the toolbox. 

4. Click the Control Wizards tool  in the toolbox, if necessary. 

5. Click the Subform/Subreport tool  in the toolbox. 

6. Click in the form or report where you want to place the top left 
corner of the subform or subreport. 

7. Select the desired option for the source of the subform or subreport. 

8. Select the desired form or report you want to insert as a subform or 
subreport. 

9. Select Next. 

10. Select the desired link option. 

11. Select the desired link for the subform or subreport from the list box. 

12. Select Next. 

13. Type a name for the subform or subreport. 

14. Select Finish. 

 

EDITING THE LAYOUT OF A SUBFORM 

 Discussion 
In order to improve the efficiency or appearance of a subform/subreport, you can 
change its layout the same way you would change the layout of a form/report. In 
Design view for the main form/report, the subform/subreport is a control that you can 
move, resize, align, add, and delete as you would any other control. Since the 
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subform/subreport control contains a form/report, you can open it in Design view and 
make any editing changes to its controls. Any changes to the layout of the 
subform/subreport are performed in Design view. 
 

  

 
You can open a subform into a separate Design window by 
right-clicking the desired subform and then selecting the 
Subform in New Window command from the shortcut menu. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the main form in Design view. 

3. Double-click the subform control you want to edit. 

4. Double-click the subform control text to select it. 

5. Make the desired editing changes. 

 

DISPLAYING A SUBFORM IN DATASHEET VIEW 

 Discussion 
You can display a subform in Datasheet view. This option allows you to view many 
subform records at once, rather than viewing them one at a time in Form view. Since 
the benefit of using subforms is to display the “many” side of a one-to-many 
relationship, Datasheet view is generally preferred. 
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A subform in Datasheet view 

 
  

 
You can add a record to both the main form and the subform 
by selecting the Insert menu and then selecting the New 
Record command. 

  

 
You can also display a subform in Datasheet view by right-
clicking in the desired field, pointing to the Subform 
command, and then selecting the Datasheet command. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the main form in Form view. 

3. Select a field in the subform. 

4. Select the View menu. 

5. Point to the Subform command. 

6. Select the Datasheet command. 
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DISPLAYING A SUBFORM TOTAL 

 Discussion 
Forms and reports often include totals of the information they contain. These totals are 
easily created by adding a calculated control to the form or report that contains an 
expression to find the desired total. Expressions are used to obtain information you 
cannot obtain directly from the tables in your database. For example, if you have a 
table that contains the quantity and cost of various items, you could use an expression 
to multiply the quantity and the cost to obtain the current inventory value. Every time 
you use a form/report, Access calculates any expressions contained in the form/report, 
helping you keep your information as accurate as possible. 
 
Some examples of expressions are listed in the following table: 

 
Control 
Name 

Expression Result 

Total =[Cost]+[Shipping]+[Markup] Adds the value of the 
Cost field, the value of 
the Shipping field, and 
the value of the Markup 
field of an item to 
produce the Total field 

Discount =[Price]*.15 Multiplies the Price field 
of an item by a constant 
discount of 0.15 

Date =Date() Provides the current date 
in your computer system 

 
You may want to include a total of information, contained in a subform/subreport, in 
the main form/report total. For example, an Orders form may contain a control for 
shipping charges. The information in the Product subform may include a total, such 
as the total cost of all the products ordered. You can display this subform total on the 
main form so that you can add the shipping charges to this total to create a grand total. 
This option is performed by adding a control to the main form/report, which refers to 
the desired subform/subreport total control, to display the information. 
 
The expression in the main form/report control that refers to the subform/subreport 
control defines the name of the subform/subreport and the name of the 
subform/subreport control being used in the following format: 

 
 = [Name of the Subform/Subreport]![Name of the Subform/Subreport Control] 
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A subform total displayed in the main form 

 
  

 
You can also display a subreport total in the main report using 
the same methods that you use to display a subform total. 

  

 
You can also display the property sheet by selecting the View 
menu and then selecting the Properties command or by right-
clicking a form or report in Design view and then selecting the 
Properties command. 

  

 
You can also display the property sheet by pressing [F4] on 
the keyboard. 

  
 

 Procedures 

1. Open the desired database. 

2. Open the form or report in Design view. 

3. Display the toolbox. 

4. Click the Text Box tool  in the toolbox. 

5. Click in the form or report where you want to insert the control. 

6. Select the label box. 
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7. Select the text in the label box. 

8. Type a label in the label box. 

9. Select the text box. 

10. Click the Properties button  on the Form Design or Report 
Design toolbar. 

11. Select the Data tab. 

12. Type the expression that refers to the desired subform control. 

13. Click the Close button to close the property sheet. 
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selecting adjacent, 82, 83 
selecting non-adjacent, 81 
sizing, 84 
sizing automatically, 85, 86 
sizing by dragging, 84 
spacing, 71 
text box, 80 
unbound, 80 
using, 80 
using the Combo Box tool, 92, 93 
using the Image tool, 73, 74 
using the Label tool, 72, 73 
using the Line tool, 75, 76 
using the List Box tool, 94, 95 
using the Option Group tool, 96, 97 
using the Rectangle tool, 74, 75 
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Data types 
assigning, 8, 11 
AutoNumber, 9 
Currency, 9 
Date/Time, 9 
Hyperlink, 10 
Lookup Wizard, 10 
Memo, 9 
Number, 9 
OLE object, 10 
Text, 9 
Yes/No, 10 

Database Wizard 
creating databases, 2, 3 

Databases 
creating, 2, 3 
creating new, 4, 5 

Date/Time formats 
setting, 21, 22 

Default values 
setting, 24 

Design view 
adding a field, 68, 69 
adding a line, 75, 76 
adding a rectangle, 74, 75 
adding an image, 73, 74 
adding labels, 72, 73 
aligning controls, 70 
creating tables, 6, 7 
disabling the Snap to Grid feature, 66, 67 
displaying the field list, 67, 68 
editing an unbound control, 76, 77 
hiding the ruler, 66 
moving part of a paired control, 69 
spacing controls, 71 
using, 7 
using the toolbox, 71 

Field descriptions 
adding, 11 

Field list 
displaying, 67, 68 

Field names 
adding, 8 

Field properties 
creating an input mask, 26, 27, 28 
limiting the field size, 18, 19 
lookup list, 33 
property types, 17 
setting date/time formats, 21, 22 
setting default values, 24 
setting number formats, 21 
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setting validation rules/text, 25, 26 
setting yes/no formats, 22, 23 
using, 17 

Field size 
limiting, 19 

Fields 
adding, 68, 69 
Yes/No, 98, 99 

Footer 
adding to a form, 101, 102 

Form Footer, 91 
Form Header, 91 
Form Wizard, 58, 59 
Forms, 58 

adding a form header and footer, 101, 102 
adding a record, 64 
adding logic controls, 98, 99 
AutoForm, 63 
basing on a query, 62 
columnar, 58 
creating, 58, 59 
creating a combo box, 92, 93 
creating a list box, 94, 95 
creating an option group, 96, 97 
creating blank, 102, 103 
datasheet, 58 
Form Wizard, 58, 59 
justified, 58 
PivotChart, 58 
PivotTable, 58 
printing records, 61 
saving as a report, 106, 107 
sections, 91 
setting the tab order automatically, 99, 100 
setting the tab order manually, 100 
tabular, 58 
using in Design view, 91 
viewing records, 60 

Header 
adding to a form, 101, 102 

Hyperlink columns 
inserting, 40 

Images 
adding, 73, 74 

Indexes 
creating a multiple field, 54 
creating a multiple field primary key, 55, 56 
creating a single field, 53 
deleting, 55 
viewing, 52, 53 

Input mask 
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creating, 27 
creating custom, 30 

Input Mask Wizard, 26, 30 
Join lines 

deleting, 50 
Labels 

adding, 72, 73 
editing text, 76 

Lines 
adding, 75, 76 

List boxes 
creating, 94, 95 

Lookup columns 
inserting, 38, 39 

Lookup field 
creating, 31, 32 
properties, 33 

Lookup list 
creating, 31, 32 

Lookup properties 
modifying, 33 

Lookup Wizard, 38 
creating a list, 31, 32 

Number formats 
setting, 19, 21 

Objects 
viewing properties, 87, 88 

Option groups 
creating, 96, 97 

Options 
sizing, 85, 86 

Page Footer, 91 
Page Header, 91 
PivotChart 

creating a view, 107, 108 
PivotTable 

creating a view, 107, 108 
Primary key 

creating a multiple field, 55, 56 
Primary keys 

setting, 11, 12 
Printing 

records in a form, 61 
Properties 

changing, 88, 89 
objects, 87, 88 
viewing, 87, 88 

Records 
viewing in forms, 60, 108 

Rectangles 
adding, 74, 75 
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Redo 
using, 77, 78 

Referential integrity 
setting, 47, 48 

Relationships 
creating between tables, 45, 46 
creating many-to-many, 41 
deleting join lines, 50 
one-to-many, 45 
one-to-one, 45 
setting referential integrity, 47, 48 
using related tables, 44 
window, 45 

Repeat 
using, 77 

Ruler 
displaying, 66 
hiding, 66 

Snap to Grid 
disabling, 66, 67 

Subdatasheets 
viewing, 49, 50 

Subforms 
creating, 112, 113 
displaying a total, 116, 117 
displaying in Datasheet view, 114, 115 
editing the layout, 113, 114 
working with, 111 

Subreports 
creating, 112, 113 
displaying a total, 116, 117 
editing the layout, 113, 114 
working with, 111 

Tab order 
setting automatically, 99, 100 
setting manually, 100 

Table Wizard 
creating a table, 13, 14 

Tables 
adding field descriptions, 11 
adding field names, 8 
assigning data types, 8, 11 
changing a column name, 35, 36 
creating in Design view, 6, 7 
creating with the Table Wizard, 13, 14 
deleting a column, 38 
deleting join lines, 50 
designing, 5 
inserting a column, 35 
inserting a hyperlink column, 40 
joining, 45 
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related, 44 
saving new, 12, 13 
setting a primary key, 11, 12 
using Design view, 7 
viewing subdatasheets, 49 

Toolbox 
using, 71 

Unbound controls 
editing, 76, 77 
labels, 80 

Undo 
using, 77, 78 

Validation rules/text 
setting, 25, 26 

Views 
Design, 71 

Wizards 
Input Mask, 26, 30 

Yes/No formats 
setting, 22, 23 

 


